Slu-ray™ Disc

user manual

o

e

the possibilities

Thank you for purchasing this Samsung product,
To receive more complete service,
please register your product af

WWW.Samsung.com/register



Safety Information

Warnin

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE THE COVER (OR BACK).
NO USER-SERVICEABLE PARTS ARE INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

A

The lighting flash and Arrowhead within the
triangle is a warning sign alerting you fo
dangerous voltage inside the product.

CAUTION: TO REDUCE THE RISK OF ELECTRIC
SHOCK, DO NOT REMOVE COVER (OR BACK).
NO USER SERVICEABLE PARTS INSIDE. REFER
SERVICING TO QUALIFIED SERVICE PERSONNEL.

The exclamation point within the triangle
is a warning sign alerting you to important
instructions accompanying the product.

WARNING

¢ To reduce the risk of fire or electric shock, do
not expose this appliance to rain or moisture.

FCC NOTE (for U.S.A)

This equipment has been tested and found to

comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are
designed to provide reasonable protection against
harmiul interference in a residential installation. This
equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful
interference to radio or television reception, which can
be determined by turning the equipment off and on.

The user is encouraged to try to correct the

interference by one or more of the following measures.

¢ Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment
and receiver.

¢ Connect this equipment into an outlet on a
circuit different from that to which the receiver is
connected.

¢ Consult the dealer or an experienced radio/TV
technician for help.

¢ This class B digital product meets all
reguirements of the Canadian Interference -
Causing Equipment Regulations.

Note to CATV system installer

This reminder is provided to call CATV system
installer's attention to Article 820-40 of the
National Electrical Code (Section 54 of Canadian
Electrical Code, Part Iy that provides guidelines
for proper grounding and, in particular, specifies
that the cable ground shall be connected to the
grounding system of the building as close 1o the
point of cable entry as practical.
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CLASS 1 LASER PRODUCT

This Compact Disc player is classified as a CLASS
1 LASER product. Use of controls, adjustments
or performance of procedures other than those
specified herein may result in hazardous radiation
exposure.

Complies with 21CFR 1040.10 except for

deviations pursuant to Laser Notice No. 50, dated

June 24, 2007.

DANGER :

s VISIBLE AND INVISIBLE LASER RADIATION
WHEN OPEN. AVOID DIRECT EXPOSURE TO
BEAM. (FDA 21 CFR)

CAUTION :

¢ CLASS 3B VISIBLE AND INVISIBLE LASER
RADIATION WHEN OPEN. AVOID EXPOSURE
TO THE BEAM. (IEC 60825-1)

¢ THIS PRODUCT UTILIZES A LASER.

USE OF CONTROLS OR ADJUSTMENTS

OR PERFORMANCE OF PROCEDURES
OTHER THAN THOSE SPECIFIED HEREIN
MAY RESULT IN HAZARDOUS RADIATION
EXPOSURE. DO NOT OPEN COVER AND DO
NOT REPAIR YOURSELF. REFER SERVICING
TO QUALIFIED PERSONNEL.

CLASS 1
KLASSE 1
LUOKAN 1

LASER PRODUCT
LASER PRODUKT
LASER LAITE
LASER APPARAT
LASER CLASE 1

KLASS 1
PRODUCTO

I NOTES |

¥ |f the Region number of a Blu-ray Disc/DVDs does not
correspond to the Reglon number of this player, the player
cannot play the disc.



Important Safetly Instructions

Read these operating instructions carefully before
using the unit. Follow all the safety instructions
listed below.

Keep these operating instructions handy for future
reference.

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.
Clean only with a dry cloth.

Do not block any ventilation openings. Install
in accordance with the manufacturer's
instructions.

No ok e

8. Do not install near any heat sources such
as radiators, heat registers, stoves, or other
apparatus (including AV receivers) that
produce heat.

9. Do not defeat the safety purpose of the
polarized or grounding-type plug. A polarized
plug has two blades with one wider than the
other. A grounding type plug has two blades
and a third grounding prong. The wide blade
or the third prong are provided for your safety.
If the provided plug does not fit into your
outlet, consult an electrician for replacement
of the obsolete outlet.

10. Protect the power cord from being walked on
or pinched particularly at plugs, convenience
receptacles, and the point where it exits the
apparatus.

11. Only use attachments/accessories specified
by the manufacturer.

12. Use only with the cart,
stand, tripod, bracket,
or table specified by the @
manufacturer, or sold with
the apparatus. When a cart ,\
is used, use caution when
moving the cart/apparatus combination to
avoid injury from tip-over.

13. Unplug this apparatus during lightning storms
or when unused for long periods of time.

14. Refer all servicing to qualified service
personnel. Servicing is required when the
apparatus has been damaged in any way,
such as when the power-supply cord or plug
is damaged, liquid has been spilled or objects
have fallen into the apparatus, the apparatus
has been exposed to rain or moisture, does
not operate normally, or has besn dropped.

Disc Storage & Manag

¢ Holding Discs
- Fingerprints or scratches on
a disc may reduce sound and
picture quality or cause skipping.
- Avoid touching the surface of a disc where
data has been recorded.
- Hold the disc by the edges so that fingerprints
will not get on the surface.
- Do not stick paper or tape on the disc.
e Cleaning Discs
- If you get fingerprints or dirt on a
disc, clean it with a mild detergent
diluted in water and wipe with a
soft cloth.
- When cleaning, wipe gently from the inside to
the outside of the disc.
¢ Disc Storage
= Do not keep in direct sunlight.
= Keep in a cool ventilated area.
= Keep in a clean protection jacket and store
vertically.

¢ Do not expose this apparatus to dripping or
splashing. Do not put objects filled with liquids,
such as vases on the apparatus.

¢ To turn this apparatus off completely, you must
pull the power plug out of the wall socket.
Consequently, the power plug must be easily
and readily accessible at all times.
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Safez‘y Information

¢ Do not plug multiple electric devices into the
same wall socket. Overloading a socket can
cause it to overheat, resulting in a fire.

Before connecting other components to this
player, be sure to turn them off.

If you move your player suddenly from a cold
place to a warm place, condensation may occur
on the operating parts and lens and cause
abnormal disc playback. If this occurs, unplug
the player, wait for two hours, and then connect
the plug to the power outlet.

Then, insert the disc, and try to play back again.
If the product makes an abnormal noise or
produces a burning smell or smoke, turn off

the power switch immediately and disconnect
the power plug from the wall outlet. Then,
contact the nearest custormer service center for
technical assistance. Do not use the product.
Using the product as it is may cause a fire or an
electric shock.

Using the 3D function

IMPORTANT HEALTH AND SAFETY
INFORMATION FOR 3D PICTURES.

Read and understand the following safety
information before using the 3D function.

& Some viewers may experience discomfort while
viewing 3D TV such as dizziness, nausea, and
headaches.

If you experience any such symptom, stop
viewing 3D TV, remove the 3D Active Glasses,
and rest.

Watching 3D images for an extended period of
time may cause eye strain. If you feel eye strain,
stop viewing 3D TV, remove your 3D Active
Glasses, and rest.

A responsible adult should frequently check on
children who are using the 3D function.

If there are any reports of tired eyes, headaches,
dizziness, or nausea, have the child stop viewing
3D TV and rest.

Do not use the 3D Active Glasses for other
purposes (Such as general eyeglasses,
sunglasses, protective goggles, etc.).

| 4 English

Do not use the 3D function or 3D Active Glasses
while walking or moving around. Using the 3D
function or 3D Active Glasses while moving
around may cause you to bump into objects,
trip, and/or fall, and cause serious injury.

If you want to enjoy 3D content, connect a 3D
device (3D compliant AV receiver or TV) 1o the
player's HDMI OUT port using a high-speed
HDMI cable. Put on 3D glasses before playing
the 3D content.

The player outputs 3D signals only through
HDMI cable connected to the HDMI OUT port.
As the video resolution in 3D play mode is fixed
according to the resolution of the original 3D
video, you can not change the resolution to your
preference.

Some functions such as BD Wise, screen size
adjustment, and resolution adjustment may not
operate properly in 3D play mode.

You must use a high-speed HDMI cable for
proper output of the 3D signal.

Stay at least three times the width of the screen
from the TV when watching 3D images. For
example, if you have a 46-inch screen, stay 138
inches (11.5 feet) from the screen.

Place the 3D video screen at eye level for the
best 3D picture.

When the player is connected to some 3D
devices, the 3D effect may not function properly.
This player does not convert 2D content into
3D.

"Blu-ray 3D" and "Blu-ray 3D" logo are
trademarks of the Blu-ray Disc Association.

© 2013 Samsung Electronics Co.,Ltd.

All rights reserved; No part or whole of this user's
manual may be reproduced or copied without the
prior written permission of Samsung Electronics
Co.,Ltd.
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Disc and Format Compatibility

R

Disc types and contents your player can play 3
(%)
Media Dise Type Details &
s =
Blu-1ay DISC | oy poM or BD-RE/-R recorded in the BD-RE format. e
3D Blu-ray Disc &
DVD-VIDEO oy
VIDEO DVD-RW e
DVD-VIDEOQ, recorded DVD-+RW/DVD-RW(V)/DVD-R/+R that have been recorded and
OVD-R finalized, or a USB storage media containing MKV, MP4 contents
DVD+RW ' g g MRS '
DVD+R
CD-RW/-R, ' '
Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
MUsIC DVD-RWIR, 1 taining MP3 or WA contents
BD-RE/-R v '
CD-RW/-R, .
Photos recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
PHOTO DVD-RW/-R, o
BD-RE/-R containing JPEG contents.

| NOTES |

» The player may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.

b If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.

Your player will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.

Your player will not play content that has been recorded on a BD-R or USB device at a bitrate that exceeds 25 Mbps.

Playback may not work for some types of discs, or when you use specific functions, such as angle change and aspect ratio
adjustment. Information about the discs Is written in detail on the disc box. Please refer to this if necessary.

» When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

v ¥

L4

Disc types your player cannot play

¢ HD DVD ¢ DVD-RAM e DVD-RW (VR mode) e 3.9 GB DVD-R for
¢ DVD-ROM/PD/ ® Super Audio CD s CVD/CD-ROM/CDV/ Authoring.
MV, etc {except CD layer) CD-G/CD-I/LD

(CD-Gs play audio only,
not graphics.)

English 7 |



Getting Started

Region Code Lot os of “Disbs_\‘theplayércaﬂ“piﬁy;‘
Both players and discs are coded by region.

These regional codes must match for a disc to e Bluroy

play. If the codes do not match, the disc will not B 5 /> 2

play.

The Region Number for this player is displayed on Blu-ray Disc 30 Blu-ray Disc

the rear panel of the player.

. Region BD, )
Disc Type Area bLI VE.. NTSC
North America, Central America, ;
) | South America, Korea, Japan, BhlE NTSC broadeast sysiem n
S®2) | Taiwan, Hong Kong and South US A anada Keiea, Japan
East Asia.
Blu-ray Disc | (72 Eur(')pe', Gree'niand, Frenoh'
.;}) territories, Middle East, Africa,
Australia and New Zealand.
7>y | India, China, Russia, Central and
w South Asia.
The U.S., U.S. territories and
Canada
Europe, Japan, the Middle East,
Egypt, South Africa, Greenland
Talwan, Korea, the Philippines,
Indonesia, Hong Kong
DVD-VIDEO Mexico, South America, '
Central America, Australia,
New Zealand, Pacific Islands,
Caribbean
Russia, Eastern Europe, India,
@ most of Africa, North Korea,
Mongolia
@ China

| 8 English



Supported Formats

R

Video File Support 3
(o]
o4
g.
(5]
*avi MPEG4 SP/ASP &‘Q
*.mkv &
* agf H.264 BP/ a
*wmy AVl MPHP
mpd MK Motion JPEG Dolby Digita!
30 ASF 1920x1080 LPCM
) Mo MP4 Microsoft (WMV V7,V8, 6~30 20 ADPCM('MA, MS)
.mpg 3GP MPEG-4v3 | MSMPEG4 v3 : AAC
*.mpeg MOV 1280x720)
‘s ALY Window Media HE-AAC
. Video v7 v8,v9 WMA
1p VRO -
- VOB Dolby Digital Plus
. p MPEG2 MPEG{MP3)
mov PS
. DTS (Core)
fv 15 MPEGT
*vob SVAF
*.5v VPG 640x480 4
*m2ls
“mts MVC 24/25/30 60
*webm WebM VP8 1920x1080 6~30 20 Vorbis
= Limitations

Even when the file is encoded by a supported codec listed above, a file might not be played if its
content is defective or corrupted.

Normal playback is not guaranteed if the file’s container information is wrong or the file itself is
corrupted.

Files having higher bit or frame rates than indicated in the table above may stutter when played back.
The Seek (Jump) function is not available if the file’s index table is damaged.

When you playback a file remotely through a network connection, video playback may stutter
depending on the network speed.

Some USB/Digital camera devices may not be compatible with the product.

Video decoder
Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)
Does not support VC1/AP/L4.

English 9 |



Getting Started

CODECs except for WMW?7, v8, MSMPEG4 v3,
MVC, VP&

1) Below 1280 x 720 : 60 frames max.

2) Above 1280 x 720 : 30 frames max.
- Does not support GMC 2 or higher.
Supports SVAF (Top/Bottom, Side by Side).
Supports BD MVC Spec.
Audio decoder
- Supports WMA 10 PRO (Up to 5.1).
Does not support WMA lossless audio.
Supports ADPCM IMA,MS.
- Does not support ADPCM(A-Law, p-Law).
Does not support QCELP/AMR NB/WB.
Supports vorbis (Up to 2¢ch).
Supports DD+ (Up to 7.1¢h)

I NOTES |

» Playback of some MKV or MP4 file may not be supported
depending on their video resolution and frame rate.

Music File Support

File
Extension Support Range

MPEG1
*.mp3 MPEG Audio
Layer 3
*.méa
*.mpa MPEG4 AAC
*.ac
*flac FLAC FLAC | Supports up to 2ch
*.009 06G Vorbis | Supports up to 2ch
Supports WMA 10
ProUpto5.1).

Does not support

“wma WMA WA WMA lossless audio.

Supports up to M2
Supported Subtitle File Formats profile.
Does not support
File LBR mode.
MPEG-4 Timed text it way way wav
SAMI smi * mid . o
SR - * midi midi midi type 0 and type 1
ubRip . :
SubViewer sub * ape ape ape
External Micro DVD sub ortxt
SubStation Alpha 884 Picture File Support
Advanced SubStation - > -
Alpha ass File Extension Resolution
Powerdivx psb . j‘fegg JPEG 1536048640
Xsub ] :
*.png PNG 4096x4096
SubStation Alpha MKV
*bmp BMP 4096x4096
Advanced SubStation MKV
Internal Alpha *mpo MPO 15360x8640
SubRip MKV
MPEG-4 Timed text MP4

[ 10 engiish



Notes on the USB connection

e Your player supports USB storage media, MP3

players, digital cameras, and USB card readers.

¢ Some USB/digital camera devices may not be
compatible with the player.

Your player supports the FAT16, FAT32, and
NTFS files systems.

Connect USB devices directly to the player's
USB port. Connecting through a USB cable
may cause compatibility problems.

Inserting more than one memory device into

a multi-card reader may cause the reader to
operate improperly.

The player does not support the PTP protocol.
Do not disconnect a USB device during a
"loading" process.

The bigger the image resolution, the longer the
image takes to display.

This player cannot play MP3 files with DRM
(Digital Rights Management) downloaded from
commercial sites.

Your player only supports video that is under
30fps (frame rate).

Your player only supports USB Mass Storage
Class (MSC) devices such as thumb drives and
USB HDD. (HUB is not supported.)

Certain USB HDD Devices, multi-card readers
and thumb drives may not be compatible with
this player.

If some USB devices require excessive power,
they may be limited by the circuit safety device.

additional power by plugging the HDD into a
wall socket.

If the problem continues, contact the USB HDD

manufacturer.

If playback from a USB HDD is unstable, provide

¢ SAMSUNG is not responsible for any data file
damage or data loss.
¢ Your player does not support NTFS compressed,
sparse, or encrypted files.
- You can repair or format a USB device on
your Desktop PC. (MS-Windows OS only)

R

AVCHD (Advanced Video Codec High
Definition)

peyels Bugien  zo

¢ This player can play back AVYCHD format discs.
These discs are normally recorded and used in
camcorders.

¢ The AVCHD format is a high definition digital
video camera format.

¢ The MPEG-4 AVC/H.264 format compresses
images with greater efficiency than the
conventional image compressing format.

e Some AVCHD discs use the "x.v.Color" format.
This player can play back AVCHD discs that use
"x.v.Color" format.

¢ "x.v.Color" is a trademark of Sony Corporation.

¢ "AVCHD" and the AVCHD logo are trademarks
of Matsushita Electronic Industrial Co., Ltd. and
Sony Corporation.

| NOTES |

» Some AVCHD format discs may not play, depending on
the recording conditions.
AVCHD format discs need to be finalized.

> "x.v.Color" offers a wider color range than normal DVD
camcorder discs.

English 111



Getting Started

Accessories

Check for the supplied accessories shown below.

Batteries for Bemote Conlrol (AAA Gizg) User Manual
4301000121 (AKEB-02280N)

Qlick Setlp Guide Bemote Contol
(AKBB-022321) (AKSG-001668)

[ 12 English



PLAY/PAUSE BUTTON

STOP BUTTON

OPEN/CLOSE BUTTON -~

POWER BUTTON

——————— USB HOST

DISC TRAY
REMOTE CONTROL SENSOR
| NOTES |
» To upgrade the player's software through the USB Host jack, you must use a USB memory stick.

» When the player displays the Blu-ray Disc menu, you cannot start the movie by pressing the Play button on the player or the
remote control. To play the movie, you must select Play Movie or Start in the disc menu, and then press the button on
the remote control.

_Rear Panel

HOMIOUT:

HDMi ouT
DIGITAL AUDIO OUT

English 13|
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Getting Started

Tour of the Remote Control

After setup, allows you to set the input
source on your TV.

(This button is only available in Samsung TV.) Turn the TV on and off.

Turn the player on and off. (This button is only available for Samsung TVs.)

TV volume adjustment.

Pross to open and dlose the disc tray. (This button is only available for Samsung TVs.)

Press the number buttons to operate
options.

Use to enter the disc menu. Use to enter the Popup menu/Title menu.

Press to skip backwards or forwards. Press to search backwards or forwards.

Press to stop a disc. Press to pause a disc.
Press to play a disc.

Press to move to the Home screen.
Press to use Apps.
Press to use Netflix.

Use to display the playback information.
Press to use the Tools menu.
Use to select menu items and change
menu values.

Return to the previous menu. Press to exit the menu.

These buttons are used both for menus
on the player and also several Blu-ray Disc
functions.

Press to search contents.

Press to use full screen function.
During the Blu-ray Disc/DVDs playback,
this button does not operate.

Press to switch the Blu-ray Disc/DVD's
subtitle language.

Use to access various audio functions on a

disc. .

| NOTES |
» |f the remote control does not operate properly:
- Check the polarity +/~ of the batterles.
- Check if the batteries are drained.
- Check if the remote sensor is blocked by obstacles.
- Check if there Is any fluorescent lighting nearby.

| CAUTION |

. » Dispose of batteries according to local environmental
“oosauv® regulations. Do not put them in the household trash.

Installing batteries

pEC Uy
w®® ®e

s ®
Posese
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Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI
IN jack on your TV.

- Do not connect the power cord to the wall outlet until you have made all the other connections.

- When you change the connections, turn off all devices before you start.

HDMI N

I NOTES |

> |f you use an HDMI-to-DVI cable to connect to your display device, you must also connect the Digital Audio Out on the player
to an audio system to hear audio.

An HDM!I cable outputs digital video and audio, so you don't need to connect an audio cable.
Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.

When you connect the player to your TV using the HDMI cable or to a new TV, and then turn it on for the first time, the player
automatically sets the HDMI output resolution to the highest supported by the TV.

Along HDMI cable may cause screen noise. If this occurs, set HDMI Deep Color to Off in the menu.
To view video in the HDMI 720p, 10801, or 1080p output mode, you must use a High speed (category 2) HDMI cable.

HDMI outputs only a pure digital signal to the TV.
If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen.

L4

L4

L4

v ¥

L4
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Connections

Connecting to an Audio System

You can connect the Blu-ray player to the audio system using the methods illustrated below.
- Do not connect the power cord 1o the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

' . Connecting to an HDMI supported AV receiver

¢ Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product 1o the
HDMI IN jack on your receiver.

¢ Best quality (Recommended)

onnecting to an AV receiver with Dolby Digital or DTS decoder

¢ Using a digital Optical cable (not supplied), connect the Optical Digital Audio Out jack on the product to
the Digital Optical In jack of the receiver.

¢ Good quality
¢ You will hear sound only through the front two speakers with Digital Output set to PCM.

Method 1 ‘ ‘ Method 2

HOME N

[ 16 english



You can connect your player to your network

router using one of the methods illustrated below.

To use the AllShare network functionality, you
must connect your PC to your network as shown
in the illustrations.

The connection can be wired or wireless.

Wired Network

Broadband modem

: (with integrated router)
Zﬁ-—-—-—@* N Broadhand

il service

o

Router

_ Broadband
service

Broadband
modem

I NOTES |

»Your router or your Internet Service Provider's policies
may prevent the player from accessing Samsung's
software update server. If this occurs, contact your
Internet Service Provider (ISP) for more information.

» DSL users, please use a router to make a network
connection.

Wireless Network

Broadband
setvice
I NOTES |
| your wireless router supports DHCP, this player can use

L4

L4

-

L4

L4

a DHCP or static IP address to connect to the wireless
network.

Set your wireless router to Infrastructure mode. Ad-hoc
mode is not supported.

The player supports only the following wireless security
key protocols:

- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES),
WPA2-PSK (TKIP/AES)

Select a channel on the wireless router that is not
currently being used. If the channel set for the wireless
router Is currently being used by another device nearby, it
will result in interference and communication failure.

If you select the Pure High-throughput (Greenfield)
802.11n mode and set the Encryption type on your router
to WEP, TKIP or TKIP-AES (WPS2Mixed), the player will
not support a connection in compliance with new Wi-F
certification specifications.

Wireless LAN, by its nature, may cause intetference,
depending on the operating conditions (router
performance, distance, obstacles, interference by other
radio devices, efc).

English 17 |
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Settings

The Initial Settings Procedure

e [he Home screen will not appeat if yoll do not
configure the inilial settings,

# The 02D (On Sereen Display) may change in this
player alter you Upgrade the software version,

® [he access sleps may ditfer depending on the menu
Yol selecled.

After you have connected the player to your TV,
turn on the TV and player. When you turn on the
player the first time, the player's Initial Settings
screen appears on the TV. The Initial Setting
procedure lets you set the On Screen Display
(OSD) and menu languages, the aspect ratio
(screen size), the network type, and connect

the player to your network. For complete Initial
Settings instructions, see the Quick Setup Guide.

I NOTES |

» |f you skip Network Setup during the Initial Settings
procedure, you can configure your network settings later.
See "Configuring Your Network Connection" on pages
26~29 for instructions.

L4

If you want to display the Initial Settings screen again and

make changes, select Settings > System > Setup in

the Home screen or select the Reset option. (See pages

22 or 25)

If you want to use an Anynet-+(HDMI-CEC) function,

please follow the instructions below.

1) Connect the player to an Anynet+(HDMI-CEC)-
compliant Samsung TV using HDMI Cable.

2) Set the Anynet+(HDMI-CEC) feature to On in both the
TV and the player.

3} Set the TV to the Initial Settings Procedure.

L4
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o Apps : Gives you access 1o various for pay or free-
of-charge applications you can download.

Photos, Videos & Music : Lets you play photos,
& | videos or music content from Disc, USB, PC or
mobile devices.

Settings : Opens the player's menu where you
@ | can set various functions to suit your personal
preferences.

Web Browser : Provides access to the Internet.

6 Recommended Apps : Gives you direct access fo
recommended applications.

Movies & TV Shows : Lets you download movies
and TV Shows from the Internet.

© |inoTEs|

» Depending on your country, this menu function
may not be supported.

I NOTES |

» I you leave the player in the stop mode for more than
5 minutes without using it, a screen saver will appear on
your TV. If the player is lefl in the screen saver mode for
more than 20 minutes, the power will automatically turn off.



1. Select Settings on the Home screen, and
then press button. The Settings screen
appears.

2. To access the menus, sub-menus, and
options on the Settings screen, please refer
to the remote control illustration below.

Buttons on the Remote Control Used
for the Settings Menu

€ | HOME Button : Press to move to the Home screen,

@ | RETURN Button : Return to the previous menu.

(Enter) / DIRECTION Buttons :
e Press AV € 1o move the cursor or select an
o item,
e Press the button to activate the currently
selected item or confirm a setting.

€ | EXIT Button : Press to exit the current menu.

Detailed Function Information

Each Settings function, menu item, and individual
option is explained in detail on-screen. To view an
explanation, use the 4 ¥ € buttons to select the
function, menu item, or option. The explanation
will usually appear on the right side of the screen.
A short description of each Settings function
starts on the next page. Additional information on
some of the functions is also in the Appendix of
this manual.

English 19 |
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Settings

Settings Menu Functions

Display

3D Settings

Select whether to play a Blu-ray Disc with 3D contents

in 3D Mode.

e |f you move to the Home or Smart Hub Home
screen while in 3D mode, the player will switch to 2D
automatically.

TV Aspect Ratio

Lets you adjust the output of the player 1o the screen
size and screen format of your TV.

BD Wise

BD Wise is Samsung's latest inter-connectivity feature.
When you connect a Samsung player and a Samsung
TV with BD Wise to each other via HDMI, and BD Wise
is on in both the player and TV, the player outputs video
at the video resolution and frame rate of the Blu-ray
Disc/DVD.

Resolution

Set the output resolution of the HDMI video signal to BD
Wise, Auto, 1080p, 1080i, 720p or 480p.

The number indicates the number of lines of video per
frame.

The i and p indicate interlaced and progressive scan,
respectively. Generally, the more lines, the higher quality.

Movie Frame (24Fs)

If the player is connected to a 24Fs compatible TV,

setting the Movie Frame (24Fs) feature 1o Auto lets the

player adjust its HDMI output to 24 frames per second

automatically for improved picture quality.

e You can enjoy the Movie Frame (24Fs) feature only on
a TV supporting this frame rate.

¢ Movie Frame is only available when the player is in the
HDMI 1080i or 1080p output resolution modes.

DVD 24Fs Conversion

Converts DVD playback to 24 frames per second and
outputs it via HDMI. This option is only available when
Movie Frame (24Fs) is set to on.

Smart Hub Screen Size

Lets you select the optimal size for the Smart Hub
Screen.

HDMI Color Format

Lets you set the color space format for the HDMI output
so that it matches the capabilities of the connected
device (TV, monitor, etc). The screen goes black
momentarily after you have selected a format.

HDMI Deep Color

Lets you set the product to output HDMI video with
Deep Color. Deep Color provides more accurate color
reproduction with greater color depth.

Progressive Mode

Lets you improve picture quality when viewing DVDs.
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Audio

Network

Digital Output

Lets you select the digital audio output format that is
suitable for your TV or AV Receiver. For more details, p—

see the digital output selection table on page 62. e

Lets you choose to have 96Khz PCM signals 17

PCM Downsamolin downsampled to 48Khz before they are outputted to an %
piing amplifier. Choose On if your amplifier or receiver is not a

[

compatible with a 96Khz signal.

Dynamic Range Control

Lets you apply dynamic range control to Dolby Digital,

Dolby Digital Plus, and Dolby TrueHD audio.

v/ Auto : Automatically controls the dynamic range of
Dolby TrueHD audio, based on information in the
Dolby TrueHD soundtrack. Also turns dynamic range
control on for Dolby Digital and Dolby Digital Plus.

v/ Off : Leaves the dynamic range uncompressed,
letting you hear the original sound.

v On : Turns dynarmic range control on for all three
Dolby formats. Quieter sounds are made louder and
the volume of loud sounds is reduced.

Downmixing Mode

Lets you select the multi-channel downmix method that
is compatible with your stereo system. You can choose
to have the player downmix to normal stereo or to
surround compatible stereo.

DTS Neo:6 Mode

You can enjoy muttichannel sound via HDMI output from
a 2 channel audio source.

Network Status

Lets you check the current network and Internet status.

Network Settings

Configure the network connection so you can enjoy
various features such as Internet services or AllShare
Wi-Fi functionality, and perform Software Updates.

Wi-Fi Direct

Lets you connect a Wi-Fi Direct device to the player
using a peer-to-pear network, without the need for a
wireless router.

Note that if the player is connected to a wireless network,
it may be disconnected when you use Wi-Fi Direct.

| NOTES |

» Text files, such as files with a .TXT or .DOC extension, will not
display when you are using the Wi-Fi Direct function.
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Network
AliShare Settings

Lets you control which devices on your network, such
as smart phones and tablets, can share content with
your TV.

Device Name

Lets you input a name for the player that will identify it
on your networks.

BD-Live Settings

Set various BD-Live functions. BD-Live allows you to

access exira features available on some Blu-ray Discs if

you are connected to the Internet.

v BD-Live Internet Connection : Lets you fully allow,
partly allow, or prohibit a BD-Live Internet connection.

v BD Data Management : Manage BD data
downloaded from a BD-Live service or Blu-ray Disc.

Smarl Features

Apps Setlings

Lets you configure App notification settings and view
basic info about your Apps.

v Push Notification Settings : Receive notifications
from selected services.

v Properties : See basic info about Apps.

VOD Rating Lock

You can lock access to Video on Demand (VOD)
content based on its rating.

I NOTES |

» Depending on your country, this menu function may not be
supported.

Terms & Conditions,
Privacy Policy

You must review and agree to both the Smart Hub
Terms & Conditions and the privacy policy in order to
enjoy Smart Hub services.

Reset Smart Hub

Resets the Smart Hub and Samsung account settings
stored on your device.

System Setup

Lets you re-run the Initial Settings procedure. See the
Quick Setup Guide for details.

Quick Start

Lets you set the player to turn on quickly by decreasing
the boot time.

I NOTES |

» |f this function is set to On, Standby power consumption will
be increased.

Language

You can select the language you prefer for the On-

soreen menu, disc menu, audio, subtitles, etfc.

¢ The language you select for the disc menu, disc
audio, or subtitles will only appear if it is supported on
the disc.
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System

Device Manager

You can connect a wireless USB keyboard or mouse 1o
the USB port on the front of the player. [

v/ Keyboard Settings : Lets you configure a wireless 2
USB keyboard connected to the player. o

[ NOTES | g.
=

» You can use the keyboard only when a QWERTY keyboard @

screen or window appears in the Web Browser.

v/ Mouse Settings : Lets you configure a wireless USB
mouse connected to the player. You can use the
mouse in the player's menu and the Web Browser in
the same way you use a mouse on your PC.

= To use a mouse with the player's menu:

1. Connect the USB mouse to the player.

2. Click the primary button you selected in Mouse
Settings. The Simple Menu appears.

3. Click the menu options you want.
| NOTES |

» Some USB HID keyboards and mice may not be compatible
with your product.

» Some HID keyboard keys may not work.
» Wired USB keyboards are not supported.
» Some applications may not be supported.

» If a wireless HID Keyboard does not operate because of
interference, move the keyboard closer to the player.
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System

|24 english

Security

The default security PIN is 0000. Enter the default PIN to
access the security function if you haven't created your
own PIN. After you have accessed the security function
for the first time, change the PIN using the Change PIN
function.

v BD Parental Rating : Prevents playback of Blu-ray
Discs with a rating equal to or above a specific age
rating you have set unless the PIN is entered.

v DVD Parental Rating : Prevents playback of DVDs
with a rating above a specific numerical rating you
have set unless the PIN is entered.

v Change PIN : Change the 4-digit PIN used to access
security functions.

= [f you forget your PIN:

1. Remove any disc or USB storage device.

2. Press and hold the @ button on the top panel for 5
seconds or more.
All settings will revert to the factory default settings.

General

You can change the options listed below to match your

preferences.

v Time Zone : Select the time zone in which you live.

v Menu Transparency : Adjust the transparency of the
menu box.

Anynet+ (HDMI-CEC)

Anynet+ is a convenient function that offers linked
operations with other Samsung players that have the
Anynet+ feature and lets you control those products
with one Samsung TV remote. To operate this function,
you must connect this player to an Anynet+ Samsung
TV using an HDMI cable.




Subport

Remote Management

When activated, lets Samsung Call Center agents

diagnose and fix problems with the product remotely. p—

Requires an active Internet connection. e

I NOTES | o

» Remote Management service might not be available in some g
countries. <

» Contact your nearest service center for your PIN code and tell
the code to the person in charge. It enables remote diagnosis
of the product and required measures.

Software Update

For more information about the Software Update
function, see "Upgrading Software" on pages 30~31.

Contact Samsung

Provides contact information for assistance with your
player.

Reset

Resets all settings to their default settings except for the
network and Smart Hub settings, and then launches the
Setup function.

The default security PIN is 0000.
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Networks and the Internet:

When you connect this player to a network,

you can use network based applications and
functions such as Smart Hub and BD-LIVE,

and upgrade the player's software through the
network connection. For more information about
accessing and using Internet services, see the
Network Services chapter of this manual on pages
44-55. Instructions for configuring the network
connection start below.

Configuring Your Network Connection

Before you begin, contact your ISP to find out

if your IP address is static or dynamic. If it is
dynamic, and you have a wired or wireless
network, we recommend using the Automatic
configuration procedures described below.

If you are connecting to a wired network, connect
the player to your router using a LAN cable before
you start the configuration procedure.

If you are connecting to a wireless network,
disconnect any wired network connection before
you begin.

To begin configuring your network connection,
follow these steps:

Wired Network

2 Wired - Automatic

1. In the Home screen, select Settings, and
then press the &) button.

2. Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wired in the Network Settings screen,
and then press the button.

5. Select Connect button, and then press the
button. The product detects the wired
connection, verifies the network connection
and then connects to the network.
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2 Wired - Manual

If you have a static IP address or the Automatic
procedure does not work, you'll need to set the
Network Settings values manually.

Follow Steps 1 and 2 in Wired Network, and then
follow these steps:

1. Select Network Status. The player searches
for a network, and then displays the
connection failed message.

2. Onthe bottomn of the screen, select IP
Settings, and then press the button.
The IP Settings screen appears.

3. Select the IP Setting field, and then press the
button.

4. Select Enter manually in the IP Setting field,
and then press the button.

5. Select a value to enter (IP Address, for
example), and then press the button.
Use the number keypad on your remote
control to enter the numbers for the value.
You can also enter numbers using the 4 ¥
buttons. Use the € B buttons on the remote
control to move from entry field to entry field
within a value. When done with one value,
press the @) button.

6. Pressthe & or ¥ button to move to another
value, and then enter the numbers for that
value following the instructions in Step 5.

7. Repeat Steps 5 and 6 until you have filled in
all values.
I NOTES |
» You can get the Network values from your Internet
provider.

8.  When finished entering all the values, select
OK, and then press the button. The
player verifies the network connection and
then connects to the network.



Wireless Network

You can setup a wireless network connection in
four ways:

- Wireless Automatic

- Wireless Manual

- WPS(PBC)

- WPS({PIN)

When you configure the wireless network
connection, any wireless network devices currently
connected through the player o, if applicable,
the player's current wired connection, will be
disconnected.

a Wireless - Automatic
1. In the Home screen, select Settings, and
then press the &) button.

2.  Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the button. The
player searches for and then displays a list of
the available networks.

5. Select the desired network, and then press

the &) button.

6. On the Security screen, enter your network's

Security Code or Pass Phrase.

Enter numbers directly using the number
buttons on your remote control. Enter letters
by selecting a letter with an arrow button, and
then pressing &3 button.

I NOTES |

» Toview the password as you enter it, use the arrow
buttons to select Show Password on the right side, and
then press &5 button.

7. When done, select Done and then press the
button. The player verifies the network
connection and then connects to the
network.

8. When verification is complete, select OK, and
then press the &) button.
I NOTES |

» You should be able to find the Security Code or Pass
Phrase on one of the set up screens you used to set up
your router or modem.

3 Wireless - Manual

If you have a static IP address or the Automatic
procedure doss not work, you'll need to set the
Network Settings values manually.

1. Follow the directions in Wireless - Automatic
through Step 5.

2. The player searches for a network, and then
displays the connection failed message.

3. On the bottom of the screen, select IP
Settings, and then press the button.
The IP Settings screen appears.

4. Select the IP Setting field, and then press the
button.

5.  Select Enter manually in the IP Setting field,
and then press the button.
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6. Select a value to enter (IP Address, for
example), and then press button. Use
the number keypad on your remote control
to enter the numbers for the value. You can
also enter numbers using the 4 ¥ buttons.
Use the € buttons on the remote conirol
to move from entry field to entry field within a
value. When done with one value, press the
button.

7. Pressthe & or ¥ button to move to another
value, and then enter the numbers for that
value following the instructions in Step 6.

8. Repeat Steps 6 and 7 until you have filled in
all values.

I NOTES |

» You can get the Network values from your Internet
provider.

9.  When finished, select OK, and then press the
button. The Security Screen appears.

10. On the Security screen, enter your network's
Security Code or Pass Phrase. Enter
numbers directly using the number buttons
on your remote control. Enter letters by
selecting a letter with the 4 ¥ € buttons,
and then pressing the button.

11. When finished, select Done at the right of the
screen, and then press the button.
The player verifies the network connection
and then connects to the network.

12. After the player verifies the network, select
OK, and then press the button.

2 WPS(PBC)

1. In the Home screen, select Settings, and
then press the &) button.

2. Select Network, and then press the
button.
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3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the button.

5. Press the 4 button on your remote, and then
press the B button to select the WPS(PBC).

6. Pressthe button on your remote. The
"Press the PBC button" message appears.

7. Press the WPS(PBC) button on your router
within two minutes. Your player automatically
acquires all the network settings values it
needs and connects to your network.

The Network Status screen appears. The
player connects to the network after the
network connection is verified.

2 WPS(PIN)
Before you begin, open the router's setup menu

on your PC and access the screen with the WPS
PIN entry field.

1. Inthe Home screen, select Settings, and
then press the &) button.

2. Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the button.
The player searches for and then displays a
list of the available networks.

5. Select the desired network, and then press
the [BJ button.

6. Select the WPS(PIN}, and then press the
B button. The PIN pop-up appears.

7. Enter the PIN into the WPS PIN entry field in

the router's Set Up screen and then save the
the screen.

I NOTES |

» Contact the manufacturer of the router for instructions
explaining how to access the route's Set Up screens or
refer to the router's user's manual.

» For WPS connection, set your wireless router's security
encryption to AES. Setting to WEP security encryption
does not support WPS connection.



Wi-Fi Direct

The Wi-Fi Direct function allows you to connect
Wi-Fi Direct devices to the player and each other
using a peer-to-peer network, without a wireless
router.

I NOTES |

» Some Wi-Fi Direct devices may not support the AllShare
function if connected via Wi-Fi Direct. If this is the case,
it Is advisable to change the network connection method
between devices.

L4

Bluetooth transmissions can interfere with the Wi-Fi
Direct signal. Before you use the Wi-Fi Direct function,
we strongly recommend that you turn off the Bluetooth
function of any active mobile device.

1. Turn on the Wi-Fi direct device and activate
its Wi-Fi Direct function.

2. In the Home screen, select Settings, and
then press the &) button.

3. Select Network, and then press the

button.
4.  Select Wi-Fi Direct, and then press the
button.

The Wi-Fi Direct devices that you can
connect appear.

5. You have three ways to complete the Wi-Fi
connection:
e Through the Wi-Fi device.
¢ Through the player using PBC.
e Through the player using a PIN.
Each is covered below.

Through the Wi-Fi Device

1. On the Wi-Fi device, follow the procedure on
the device for connecting to another Wi-Fi
Direct device. See the device's user manual
for instructions.

2. When you have completed the procedure,
you should see a pop-up on your TV screen
saying that a device that supports Wi-Fi
Direct has requested to connect. Select OK,
and then press the button to accept.

3. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,
you should see the device listed on the Wi-Fi
Direct screen as connected.

Through the Player Using PBC

1. Select the Wi-Fi Direct device you want to
connect to this player, and then press the
button. The PBC/PIN pop up appears.

2. Select PBC, and then press the button.
The PBC pop-up appears.

3. Press the PBC button on the Wi-Fi Direct
device within 2 minutes.

4. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,

you should see the device listed on the Wi-Fi
Direct screen as connected.

B
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Through the Player Using a PIN

1. Select the Wi-Fi Direct device you want to
connect to this player, and then press the
button. The PBC/PIN pop up appears.

2. Select PIN, and then press the button.
The PIN pop-up appears.

3. Note the PIN code in the pop-up, and then
enter it into the appropriate field in the Wi-Fi
Direct device you want to connect.

4. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,
you should see the device listed on the Wi-Fi
Direct screen as connected.

| NOTES |

» The current wired or wireless network connection will be
disconnected when you use the Wi-Fi Direct function.

» Text files, such as files with a . TXT or .DOC extension, will
not display when you are using the Wi-Fi Direct function.
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The Software Update menu allows you 1o
upgrade the player's software for performance
improvements or additional services.

® Never tuin the player off or back on manually during
{he lindale plocess.

In the Home screen, select the Settings, and

then press the {&J button.

Select Support, and then press the
button.

Select Software Update, and then press the

button.
To download update software and update

now, select Update Now, and then press the
button. See Update Now on this page for

details.

To let the product download update software

automatically when available, select Auto

Update, and then press the button. See

Auto Update on page 31 for details.

I NOTES |

b

The upgrade is complete when the player turns off, and
then turns on again by itself.

Samsung Electronics shall takes no legal responsibility
for player malfunction caused by an unstable Internet

connection or consumer negligence during a software
Update.

If you want to cancel the upgrade while the upgrade
software is downloading, press the button.

When a system upgrade Is in progress, "UPDATE" Is
displayed on the front panel.

30 english

Update Now

You can use Update Now to update the software
through your network connection or by using a
USB flash drive. The network instructions are
below. The USB flash drive instructions are on the
next page.

1. Select Update Now, and then press the
button.
The Update now pop-up appears.

2. The product searches on line for the latest
software version.

3. [Ifitfinds a new version, the Update Request
pop-Up appears.

4. Select OK. The product upgrades the
software, turns off, and then turns on
automatically.

5. If you do not select OK or Cancetl in one
minute, the product stores the new upgrade
software. You can upgrade the software later
using Auto Update.

6. If you select Cancel, the product cancels the
upgrade.

I NOTES |

» When the system upgrade is done, check the software
details in the Product Information section of the Contact
Samsung screen.

» Do not turn off the player during the Software Update. It
may cause the player to malfunction.



Auto Update

You can set the Auto Update function so that the
player downloads new upgrade software when it
is in Auto Update mode.

In Auto Update mode, the player is off, but its
Internet connection is active. This allows the player
to download upgrade software automatically,
when you are not using it.

1. Press the 4 ¥ buttons to select Auto
Update, and then press the button.

2. Select On or Off.
If you select On, the player will automatically
download new upgrade software when it is
in Auto Update mode with the power off. If it
downloads new upgrade software, the player
will ask you if you want to install it when you
turn the player on.

I NOTES |

» To use the Auto Update Mode Upgrade function, your
player must be connected to the Internet.

< By USB >

1. Visit www.samsung.com.
Click SUPPORT on the top right of the page.

3. Enter the product's model number into the
search field. As you enter the model number,
a drop down will display products that match
the model number.

4. Left click your product's model number in the
drop down list.

5. On the page that appears, scroll down to and
then click Firmware Manuals & Downloads.
Click Firmware in the center of the page.
Click the ZIP button in the File column on the
right side of the page.

8. Click Send in the first pop-up that appears.
Click OK in the second pop-up to download
and save the firmware file to your PC.

9. Unzip the zip archive to your computer. You
should have a single folder with the same
name as the zip file.

B

10. Copy the folder 1o a USB flash drive.

11. Make sure no disc is inserted in the product,
and then insert the USB flash drive into the
USB port of the product.

12. In the product’s menu, go to Settings >
Support > Software Update.

13. Select Update Now.
14. The product searches for the software on the

USB drive. When it finds the software, the
Update Request pop-up appears.
15. Select OK. The product upgrades the

software, turns off, and then turns on
automatically.

I NOTES |

» There should be no disc in the player when you upgrade
the software using the USB jack.

» When the system upgrade is done, check the software
details in the Product Information section of the Contact
Samsung screen.

» Do not turn off the player during the Software Update.
It may cause the player to malfunction.

» Software Updates using the USB jack must be performed
with a USB flash memory stick only.

sbumies 40
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Media Flay

Your Blu-ray Disc Player can play content located
on Blu-ray/DVD/CD discs, USB devices, PCs,
smart phones, tablsts, and on the Web.

To play content located on your PC or on mobile
devices, you must connect them and this product
to your network. To play content on your PC, you
must also install Allshare network software on your
PC.

I NOTES |

» PCs running Windows 7 and Windows 8 have Allshare
software (Play To} built in.

The AliShare Play Screen

For all media, the AllShare Play Main screen or
one of its sub screens is your primary means of
accessing and playing contents saved on a variety
of devices, either connected directly or using your
network.

Accessing the AllShare Play Screen

To access the AllShare Play Main screen, select
Photos, Videos & Music on the Home screen,
and then press the button.

Playing Commercial Discs

1. Pressthe button to open the disc tray.

2. Place a disc gently into the disc tray with the
disc’s label facing up.

132 English

3. Press the &8 button to close the disc tray.
Playback starts automatically.

4. If playback does not start automatically, press
the £8 button on the remote control.

Playing Files on a USB Device

There are two methods you can use to play or
view multimedia files located on a USB device
through your player.

Method 1

1. Turn the player on.

2. Connect the USB device to the USB port on
the front panel of the player. The New Device
Connected pop-up appears.

I NOTES |
» |f the pop-up does not appear, go to Method 2.

3. Usethe 4 ¥ buttons to select Photos,
Videos, Music or All Content, and then
press the button. The AllShare Play
screen appears listing the content of the
device. Depending on how the contents is
arranged, you will see either folders, individual
files, or both.



I NOTES |

Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the All Share Play screen and
going 1o Step 4 in Method 2 below.

L4

4. Ifnecessary, use the the 4 ¥ € buttons
to select a folder, and then press the
button.

5. Select afile to view or play, and then press
the [ button.

6. Press the RETURN button to exit a folder
or the EXIT button to return to the Home
screen.

7. Go to pages 36~43 for instructions that
explain how to control playback of videos,
music, and pictures on a USB device.

Method 2

1. Turn the player on.

2. Connect the USB device to the USB port on
the front panel of the player.

3. Select Photos, Videos & Music on the
Home screen, and then press the button.

4. Select Photos, Videos, Music or All
Content, and then press the button.

I NOTES |

» Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the AliShare Play screen and
repeating Step 4.

5. Use the € ¥ buttons to select the desired
device and then press the button.
Depending on how the contents are
arranged, you will see either folders, individual
files, or both.

6. Ifnecessary, use the A ¥ €4 b buttons to
select a folder, and then press the button.

7. Usethe 4 ¥ €b buttons to select afile to
view or play, and then press the button.

8. Press the RETURN button to exit a folder or
the EXIT button to return to Home screen.

9. Go to pages 36~43 for instructions that
explain how to control playback of videos,
music, and pictures on a USB device.

I NOTES |

» | you insert a disc when playing a USB device, the device
mode changes to "Disc" automatically.

Playing a Disc with Use‘ ;Recorded

You can play multimedia files you have recorded
on Blu-ray, DVD, or CD discs.

1. Place a user recorded disc into the disc
tray with the disc’s label facing up, and then
close the tray. The Device Connected pop-up
appears.

2. Usethe 4V buttons to select the type of
content you want to view or play - Photos,
Videos, Music, or All Content - and then
press the @) button.

| NOTES |

» Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the AliShare Play screen and
repeating Step 2.

3. Ascreen appears listing the contents of the
disc. Depending on how the contents are
arranged, you will see either folders, individual
files, or both.
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4. If necessary, use the 4 ¥ € buttons to 5. On the Download Tab, click Software.
select a folder, and then press the &) button. g | the list of software, click the EXE button on
5. Usethe € ¥ 4 ¥ buttons to select a file to the right side of the Allshare software line.
view or play, and then press the {& button. 7. Inthe pop-up that appears, click the Send
6. Press the RETURN button one or more times button.
to exit a current screen, exit a folder, or to 8. In the next pop-up, click Save File.

return to the Home screen.
Press the EXIT button to return directly to the
Home Screen.

Find the Allshare install file on your disk, and
then double click the file.

10. In the pop-up that appears, click Run, and
then follow the directions that appear on your
screen.

7. Go to pages 36~43 for instructions that
explain how to control playback of videos,
music, and pictures on a disc.

Download the Allshare software Installation/
Instruction manual from the same Software Tab by
clicking the corresponding PDF file symbol in the
File column on the right. The file, in PDF format,

will download and open. You can view and/or
Allshare software lets you play Photos, Videos, save the file.

or Music located on your PC or your Allshare
compatible device through the player using a
wireless connection.

To Download the Allshare Software

If your PC is not running Windows 7 or 8, you must
install Allshare software on your PC to use the
Allshare function. You can download the Allshare
software and get detailed instructions for using the
Allshare software from the Samsung.com website.

1. Go to www.samsung.com.
2. Click Support at the top of the page.

3. On the Support page, enter the model
number of your player into the Model Number
field, and then press the button.

4. On the page that appears, click See All
Downloads on the left side of the screen
under Downloads. The Download Tab
appears.
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Playing Content Located on Your PC

Controlling the Playback of Content

or Allshare Device through the Blu-ray Located on Your PC with Your Smart —
Disc Player Phone b
PC Blu-ray Disc Player PC Blu-ray Disc Player §
2
T
o
-

Play back
PC's files

AliShare Connection

1. Connect the Blu-ray Disc Player, your PC,
and/or your Allshare compatible device to the
same wireless network.

2. Follow the directions in the Allshare software
Installation/Instruction manual to set up
devices and files for playing or viewing.

3. Select Photos, Videos & Music on the
player's Home screen, and then press
the button. The AllShare Play screen
appears.

4.  Select the type of content you want to play
- Photos, Videos, Music, or All Content -
and then press the button.

5. On the next screen, select Alishare, and then
press the & button.

6. Inthelist of Allshare connected devices that
appears, select your PC or other Allshare
compatible device, and then press the
button. A screen listing the available files
appears.

7. Select the file you want to play or view, and
then press the &5 button.

Play back
PC's files

AliShare Control PC's files on the
Connection Blu-ray Disc Player

Allshare Smart Phone

(Only available with Samsung phones supporting
Allshare functionality.)

1. Connect the Blu-ray Disc Player, your PC,
and your Allshare compatible cellular phone
to the same wireless network.

2. Follow the directions in the Allshare software
Installation/Instruction manual to set up
devices and files for playing or viewing.

3. On your computer, using the Allshare
software, confirm your phone is connected.

4. On the phone, select the file you want to view
or play, and then select the Blu-ray player as
the playback device.

5. On the phone, start playback.
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Controlling Video Playback

You can control the playback of video content located on a Blu-ray/DVD disc, USB, mobile device or PC.
Depending on the disc or contents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback

Playback related buttons
The player does not play sound in Search, Slow or
Step mode.

¢ To return to normal speed playback, press the
button.

button | Starts playback.
2 button | Stops playback.
i7 bution Pauses playback.
During playback, press the €8} or B3
Fast Motion | button.
Play Each time you press the &83 or Ba
button, the playback speed will change.
. In pause mode, press the £ button.
plow Mation Each time you press the &3 button, the
Play \
playback speed will change.
. In pause mode, press the B button.
glt:p T Each time you press the €8 button, a
¥ new frame appears.
During playback, press the B2 or
. . button.
ﬁgs L Each time you press B8 or &) button,

the disc moves to the previous or next
chapter or file.

136 english

=8 Using the disc menu, title menu, popup

menu, and title list

DISC MENU | During playback, press this button fo
button display the Disc menu.

During playback, press this bution to
TIILE MENU | display the Title menu.
buiton e |f your disc has a playlist, press the

View 1o go 1o the playlist.

POPUP MENU | During playback, press this button to
bution display the Popup menu.

Using the Tools Menu

During playback or in pause mode, press the
TOOLS button.

Play from the | Select to return to the beginning of the
Beuinning movie, and then press the button.

Use 3D menu to select Side by Side
or Top and Bottom option if the 3D
content currently playing does not
properly appear in 3D mode.

| NOTES |

» Use 3D menu for 3D contents only.
If applied to 2D contents, it may not
be displayed properly.

3D

Movie Note provides information such
as director, cast, synopsis, etc.

I NOTES |

» This function Is available If the disc
includes Movie Note information
and the player is connected to a
network.

Movie Note

You can use the Search Scene function
during playback to view or start a
movie from the scene of your choice.

Search Scene




Search Scene

Search Tiiles

Search
Chapters

Search Time
Bar

I NOTES |

» |f the index information in the file
is damaged or the file does not
support indexing, you will not be
able to use the Search Scene
function.

» If you are using the Allshare function
after connecting to a computer
through your network, Search
Scene may not be supported.

If there Is more than one movie on the
disc or device, select to start a different
itle.

1. Select Search Titles, and then
press the &3 button.
2. Usethe AW buttons to select

aftitle, and then press the
button.

Select to play the chapter of your
choice.

1. Select Search Chapters, and then
press the &3 button.
2. Usethe A'Y buttonstoselecta

chapter, and then press the
button.

Select to play the movie from a
selected time point.

1. Select Search Time Bar, and then
press the &3 button.

2. Using the number buttons, enter
the time point you want fo go to,
and then press the button.

I NOTES |

» You can also use the € ® butlons
to advance or rewind the movie.
The movie advances or rewinds one
minute each tme you press the <
B buttons.

Bepeat Mode

Picture Made

Audio

Select to repeat a title, chapter, or
specific section.

Off : Select to return to normal
playback.

- Title : Choose to repeat a selected
title.

Chapter : Choose to repeat a
specific chapter.

Repeat A-B : Choose to repeat a
specific section.

1. Press the 4 ¥ butlons to select
repeat A-B, and then press the
button,

2. Pressthe button at the point
where you want repeat play to start
(A). Let the movie play.

3. Pressthe button at the point
where you want repeat play to stop
B).

I NOTES |

> You must set point (B) at least 5

seconds of playing time after point
(A

Select to set the picture mode.
Dynamie : Increases sharpness and
brightness.

Standard : Choose this setting for
most viewing applications.

- Movie : The best setting for
watching movies.

User : Lets you adjust the sharpness
and noise reduction function
respectively.

I NOTES |

» When you use the BD wise function,
this menu will not appear.

Select to set the desired audio
language.
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Select fo set the desired subtitle
language.

Sublitle - You can also operate this function
by pressing the SUBTITLE button on
the remote control.

Subtitle Select to set the desired subtitle

Settings options.

Select to view a scene from another
angle. The Angle option displays the

Anle number of angles avallable to view.

g When a Blu-ray Disc/DVD contains
multiple angles of a particular scene,
you can change angle.

BONUSVIEW

Video Select to set the desired bonusview

BONUSVIEW | option.

Audio

Select to set the size of the video
image. Choose Original, Mode 1
(larger), or Mode 2 {largest).

Full sereen

Displays all the video files on the media

e or storage device by title.
Displays all the folders with videos by
Date date. If you select a folder, and then
press the button, displays all the
videos in the folder by date.
Folder Displays all 'the folders on the media or
storage device.
Playlist Displays available play lists.
Displays all the video files on the media
Title List or storage device by title. Alternate to
Title.
I NOTES |

» Depending on the disc or storage device, the View menu
may differ or not be shown.

Using the Options Menu

Information Select to view video file information.

I NOTES |

» Depending on the disc or storage device, the Tools menu
may differ or not be shown.

> Video files with high bitrates of 20Mbps or more strain
the player's capabilities and may stop playing during
playback.

Using the View & Options Menus

Using the View Menu

On the video file playback screen, use the 4 ¥ € b
buttons to select View and then press the
button.
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On the video file playback screen, use the AV <t b
buttons to select Options and then press the
button.

Lets you create a playlist by selecting
specific files o play. It works essentially
the same way for all media. See
Creating a Playlist on an Audio CD on
pages 40~41,

Play Selected

Select to upload selected files to on-
line sites (Picasa, Facebook etc) or a
device. To use this function, you need
to establish an account with the on-line
site, and then log In using the Log In
function.

Send

Delete Select fo delete a file from a device.

I NOTES |

» Depending on the disc or storage device, the Options
menu may differ or not be shown.



You can control the playback of music content

located on a DVD, CD, USB, mobile device or PC.

Depending on the disc or contents, some of the
functions described in this manual may not be
available.

Buttons on the Remote Control used
for Music Playback

Using the View & Options Menus

B

NUMBER buttons . If numbered tracks are displayed,
press the number of a track. The selected track is
played.

B ED button : Moves to the previous/next track.

2 ®

€3 button : Stops a track.

Fast Play (Audio CD (CD-DA) only)

o During playback, press the 83 or £ button.
Each time you press the €8} or B8 button, the
playback speed will change.

@ | @ bution : Pauses a frack.

o button : Plays the currently selected track.

Using the View Menu b
On the music file playback screen, use the AV b z
buttons to select View, and then press the 8
button. o
e
, ) £
Tack Disp!ays all the mustg tracks on the
media or storage device.
Albun Displays all 'musm on the media or
storage device by album.
Atist Disp!ays all the the m'ustc ﬂies'on the
media or storage device by artist.
Displays all the music on the media or
Genre )
storage device by genre.
Folder Displays all ﬁhe folders on the media or
storage device.
I HOTES |

» Depending on the disc or storage device, the View menu
may differ or not be shown.

Using the Options Menu

On the music file playback screen, use the AV <
buttons to select Options and press the button.

Lets you create a playlist by selecting
specific files to play. It works essentially

Play Selected | the same way for all media. See
Creating a Playlist on an Audio CD on
pages 40~41,

Select to send selected files to other

Send

devices.
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The Ripping function converts CD Shuffling Tracks on an Audio CD
audio to the mp3 format and saves the

You can set the product to play tracks on an audio

Ripping converted files on a USB device or the CD (CD-DA/MPS) at random
mobile device connected to the player. ’
See Ripping on page 41. 1. On the Playback screen, use the AV € b
buttons to select DK in the lower left corner
. Select fo see the (Contents)
Information information of the screen, and then press the button.
- 2. Usethe 4 ¥ to set the Shuffle mode On or
Encoding igéﬁfg;" manage the text encoding Off, and then press the [&) button.
Delete Select to delete a file from the device. Creating a Playlist from an Audio CD
| NOTES | 1. With the Playback screen displayed, select

the Options button, and then press the
» Depending on the disc or storage device, the Options button. The Options menu appears.

menu may differ or not be shown. 2. Usethe 4V buttons to select Play Selected,

and then press the button. The Selection

Repeating Tracks on an Audio CD Play screen appears.

You can set the product to repeat tracks on an 3. Use the & ¥ buttons to select a track, and
audio CD (CD-DA/MP3). then press the button. A check appears

1. On the Playback screen, use the A ¥ <4 b o the left of the track.

buttons to select € in the lower left corner 4. Repeat Step 3 to select and check additional
of the screen, and then press the [B3 button. tracks.

2. Usethe & ¥ to select the repeat mode you 5. Toremove a track from the list, move to the
want - Off, One Song, or All - and then track, and then press the button again.
press the button. The check on the track is removed.

6.  When done, press the 4 ¥ button to select
Play, and then press the button. The
Music Playback screen reappears listing only
the tracks you checked. The selected tracks
play automatically.

I NOTES |

» You can create a playlist with up to 99 tracks on Audio
CDs (CD-DA).

» If you have created a playlist, Play Selected is replaced
by Edit Playlist on the Options menu.

» On the Selection Play screen, you can also choose Select
All, Clear All, and Cancel.
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Use Select All o select all tracks. This cancels

your individual track selections. When you press the
RETURN button on your remote control or select the
Play button, and then press the button, all tracks
will appear on the Music Playback screen, and the
product will begin to play all tracks from Track 001.

Use Clear All o deselect all selected tracks at once.
Then, select individual tracks or use Select All to
select all the tracks, and then press the RETURN
button on your remote control. If you do not use Select
All or select individual tracks, the Playlist will not
change.

Cancel cancels any changes you made on the Play
Select screen. When you return to the Playback screen,
the Playlist will be unchanged.

Ripping

1.

Insert a USB device into the USB jack on the
front of the product.

With the Playback screen displayed, select
the Options and then press the button.
The Options menu appears.

Use the 4 ¥ buttons to select Ripping,
and then press the button. The Ripping
SCreen appears.

Use the 4¥ buttons to select a track, and
then press the button. A check appears
to the left of the track.

Repeat Step 4 to select and check additional
tracks.

To remove a track from the list, move to the

track, and then press the button again.

The check on the track is removed.

When done, select the Rip button using the
4 ¥ buttons, and then press the button.
The Rip pop-up appears.

Use the 4 ¥ buttons to select the device to

store the ripped files to, and then press the

button.

| NOTES |

» Do not disconnect the device while ripping Is in progress. —

9. If you want to cancel ripping, press the
button and then select Yes. Select No to
continue ripping.

When ripping is complete, the "Successiully
Ripped." message appears. Press the
button.

11. Press the RETURN button or select Cancel,
and then press the button to go back to
the Playback screen.

I HOTES |

» This function is not available with DTS Audio CD.

» This function may not be supported by some discs.

» Ripping encodes music to the .mp3 format at 192kbps.

» On the Ripping screen, you can also choose Select All
and Clear All.

- Use Select All to select all tracks and press the
button. This cancels your individual frack selections.

- Use Clear All to deselect all selected tracks at once.

10.

Aeid eipsy SO

Playing Photo Contents

You can play photo contents located on a DVD,
USB, mobile device or PC.

Using the Tools Menu

During playback, press the TOOLS button. A
series of icons appears at the bottom of the
screen. The icons, which are shown from left to
right on the screen, are shown in the same order,
from top to bottom, in the table below.

Previous Select to move to the previous picture.
Next Select to move to the next picture.
Start / 8lop '

Slide Show Select to play/pause the slide show.
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Shd? Show Select the Slide Show setlings.
Seltings

Select to enlarge the current picture.
Zoom ,

(Enlarge up to 4 times)

Select to rotate the picture. (This will
Rotate rotate the picture either clockwise or

counter clockwise.)
Backaground Select to listen to music while viewing
Music a slide show.

Select the picture mode - Dynamic,
Settings Standard, Movie, or User - or display

information about the current picture.
I NOTES |

» Depending on the disc or storage device, the Tools menu
may differ or not be shown.

To enable the background music function, the photo file must
be in the same storage media as the music file.

However, the sound quality can be affected by the bitrate of
the MP3 file, the size of the photo, and the encoding method.

You can't enlarge the subtitle and PG graphic in the full
screen mode.

L4

L 4

Using the View & Options Menus

Using the Options Menu

Using the View Menu

On afile screen containing photo files, select the
View and press the button.

Displays all the photo files on the media

Tite or storage device by title.
Groups all the the photo files on the
Date media or storage device by date. Click a
group to see the photos in that group.
Folder Displays all 'the folders on the media or
storage device.
I HOTES |

» Depending on the disc or storage device, the View menu
may differ or not be shown.
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On a file screen containing photo files, select the
Options and press the button.

Starts the slide show. Shows all the
files in the current folder, one after
another. If you want fo create a slide
show with a selected group of photos,
see Play Selected below.

Slide show

Lets you create a playlist by selecting
specific photos 1o see. It works
essentially the same for all media.
See Creating a Playlist from an Audio
CD on pages 40~41 for instructions.

Play Selected

Select fo upload selected files to an
on-line site (Picasa, Facebook etc) or a
device. To use this function, you need
to establish an account with the on-line
site, and then log In using the Log In
function. See Using the Send Function
on page 43.

Send

Select fo delete the a file from the

Delete X
device.

I NOTES |

» Depending on the disc or storage device, the Options
menu may differ or not be shown.



Using the Send Function

You can upload files to an on-line site (Picasa,
Facebook etc) or a device.

1.

With the Photo Playback screen displayed,
select the Options button, and then press
the button. The Options menu appears.

Use the 4 ¥ buttons to select Send, and
then press the button. The Selection
screen appears.

Use the 4 ¥ buttons to select a picture, and
then press the button. A check appears
to the left of the picture.

Repeat Step 3 to select and check additional
pictures.

To remove a picture from the list, move to the
picture, and then press the button again.
The check on the picture is removed.

When done, press the 4 ¥ button to select
Send, and then press the button.

The Send pop-up appears listing the on-line
sites (Picassa, Facebook, etc.) or devices
that you can send the photos to.

Select a destination, and then press the
button.

If you are sending the photos to an on-line
site, the site starts. Log in and follow the
directions on the screen.

I NOTES |

b

To send photos to an on-line site you must have an
account with that site.
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Network Services

You can enjoy various network services such as
streaming video or on-line apps by connecting the
player to your network.

1o Use network setvices, youl inust first:

1.  Connect the plaver to the network,
(See page 17)

2. Conllgute the network sellings,
(See pages 26-29)

Before you access Movies & TV Shows or Apps,
we suggest you log in to your Samsung account.

I NOTES |

» |f you do not have a Samsung account, follow the
directions in the Quick Startup Guide to create one.

To log in to your Samsung account, follow these

steps:

1. With the Home screen displayed, press the
RED (A) button. The Log In screen appears.

2. Select the Email field, and then press the
button. The keyboard pop-up appears.

3. Using the keyboard, enter your e-mail
address. When finished, select the Done
button, and then press the button. The
Log In screen re-appears.

4. Select the Password field, and then press the
button. The keyboard pop-up appears.

5. Using the keyboard, enter your password.
When finished, select the Done button, and

then press the button. The Log In screen
re-appears.
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6. To make the log in process easier next time,
select Sign me in automatically, and then
press the &) button.

7. Select Log In, and then press the button.
The player logs you in to your account. Your
account e-mail is displayed on the bottom left
of the screen.

I NOTES |

» If you selected Sign me in automatically, the next time
you log in, the player will automatically enter your e-malil
and password. All you need fo do is select Log In.

» |f your e-mall address and password are not displayed
when the Log In screen appears, select the button with
the down pointing arrow head next to the Email field, and
then press the button. A drop down list of all your
registered accounts will appear. Select your account,
and then press the button. The player will fill in the
e-mall and password fields.

» |f you press the RED (A) button after you have logged
in, the My Account pop-up appears. On the pop-up, you
can select Logout, Change Account Information, Link
Service Accounts, Remove Accounts from the Device,
and Deactivate Account.

» To rent movies and purchase for-pay apps, you must have
a credit card registered in your account. If you haven't
registered a card, select Change Account Information.
On the Change Account information page, select
Register Card, press the button, and then follow the
directions on the screen.

ing Movies & TV Shows |

If you haven’t set up Smart Hub, when you use
Movies & TV Show or Apps for the first time, the
player will ask you to perform the Smart Hub set
up procedure.



On the Home screen, select either Movies &
TV Shows or Apps, and then press the
button. If you have selected Apps, go to Step 4.

If you selected Movies & TV Shows, the
Smart Hub pop-up appears asking if you
want to set up Smart Hub. Select Yes, and
then press the button. The Welcome
SCreen appears.

Select Start, and then press the button.
The Smart Hub Terms & Conditions, Privacy
Policy screen appears.

On the Smart Hub Terms & Conditions,
Privacy Policy screen, you must review and
agree to both the Smart Hub Terms and
Conditions and the Privacy Policy to use
Smart Hub.

Scroll down, and then click the View Details
buttons to review the full documents.

When done reading, scroll up to the first entry
field, and press the button to agree to
the Terms and Conditions and consent to the
Privacy Policy.

Press the B button twice to go to the
Supplemental Privacy Notices screen.

Click the View Details button to view the
entire notice.

When done reading, scroll up to the top entry
field, and then press the button.

| NOTES |
» You do not need to consent to the Supplemental

Privacy Notice, but one or more Smart TV features or
functionalities may not be available if you do not.

10. Press the B button twice. The Setup

Complete screen appears. Press the
button.

You can download or stream for pay and free-of-
charge movies and TV shows and view them on
your TV.

On the Home screen, select Movies & TV
Shows, and then press the button.

Select one of the Featured or Recommended
movies, and then press the button. The
page for that movie appears.

OR
Use the ¥ button to go to the bottom of
the screen. Select Favorites, Featured, TV
Shows, Movies, or Purchased, and then
press the & button.
On the page that appears, use the A ¥ € »
buttons to select a show or movie, and then
press the {8 button.
On the TV Shows or Movies screen, you can
also select What's New, Most Popular,
or Genres 1o see more available shows
or movies. On the Genre screen, use the
4V €p buttons to select a Genre, and then
press the @ button.
To make a selection on a page displaying TV
shows or movies, use the 4 ¥ €& buttons
to make a selection, and then press the
button.

English 45 |

L

SOOIAISS MIOMIBN 90



Network Services

3. To watch a selection, select Watch now, and
then press the button. A selection screen o
appears listing various locations from which
you can rent the film along with prices.

4. Select alocation, and then press the Featured Applications : Use the 4 ¥ € buttons

button. Follow the directions on the screen 1o o to highlight the displayed Feature Application, and
start the movie. then press the button. Information about the

featured application appears

Downloaded : Select to access the Downloaded
screen where you can add to, modify, and delete
applications and see all downloaded applications.

I NOTES |

If you haven't logged into your Samsung account, the Log
In screen will appear after Step 3 and you will need to log You can download for pay or free-of-charge
n. applications through Samsung Apps.

If you don't have a credit card associated with your 1.

Downloading Applications

L4

L4

On the Apps screen, select Samsung Apps,

Samsung account, after you log In, the Register Card and then press the button. The Samsung
screen will appear. Follow the directions on the screen.

You must have a credit card registered to your account to
rent movies and to purchase for-pay apps.

Apps screen appears.

2. Across the top of the screen, under What'’s
New, you'll see a series of new apps. Use
the 4B buttons 1o scroll the list right or left,

Usmg Apps . and then select an app. Press the & button
— to see more information about the app. If the
You can download applications from the Internet, app is free, select Download, and then press
and access various for pay or free-of-charge the {&; button to download the app.
application and view them on your TV. To access Ifit is a for pay app, select Buy, press the
some applications, you need to have a Samsung button, and then follow the instructions
account. on the screen.
The Apps Screen at a Glance | NOTES |

» To buy an app, you must be logged Into your Samsung
account and have a credit card registered to the account.
Press the RED (A} button on your remote to log in.

If you haven't registered a card, after you log In, press the
RED (A) button again, and then select Change Account
Information in the pop-up that appears. On the Change
Account information page, select Register Card, press
the button, and then follow the directions on the
screen.

You can also access and download apps from the

categories listed on the left of the screen. For instructions,
see Step 4.

A4

L4

© Recommended : Displays recommended contents
managed by Samsung.

o My Apps : Displays your personal gallery of
applications modifiable on the Downloaded screen.
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3. After the app has downloaded, select Run,
and then press the button to run the app
now. To run the app later, press the RETURN
button. In either case, the icon for the app will
appear on the Apps screen.

4. To see additional apps, use the AV 4 b
buttons to move to the category list on the
left side of the screen.

5. Usethe 4 ¥ buttons to select a category.
Each time you move the highlight to another
category, a different set of applications
appears on the right.

6. Use the B button to move to the applications
and the 4 ¥ € buttons to move from app
to app.

7. To see more information about an app, select
it, and then press the button.

8. To download the app, follow the directions in
Steps 2 and 3.

Starting an Application

1. Select Apps on the Home screen, and then
press the &) button.

2. Onthe Apps screen, use the 4 ¥ < buttons
to select an app, and then press the
button. The app starts.

Using the Downloaded Screen

The Downloaded Screen lists all the apps you

have downloaded and lets you:

¢ Sort the apps on the Downloaded screen by
Date downloaded, Recently opened, and
Title.

¢ Apply a number of Edit Menu functions to the
apps listed in the My Apps section of the Apps
screen including updating apps, moving apps
into a folder, deleting the apps from My Apps,
and locking the apps.

¢ Start apps.

Sorting the Apps

To sort the apps on the Download screen, follow
these steps:

1. On the Home screen, select Apps, and then
press the & button.

2. On the Apps screen, use the ¥ button to
move to the Downloaded hotspot at the
bottom of the page, and then press the
button.

3. Onthe Downloaded screen, use the A
buttons to move to View at the top of the
screen, and then press the button.

4. In the drop down that appears, select Date
Downloaded, Recently Opened, or Title,
and then press the button. The apps on
the Downloaded screen are sorted by the
criteria you have chosen.

Using the Edit Menu Functions

Lock/Unlock

Using the Lock/Unlock function and the Security
PIN, you can lock applications so they cannot
be started on either the Apps screen or the
Downloaded screen. The default PIN is 0000.

1. Onthe Downloaded screen, use the A
buttons to go to Edit at the top of the screen,
and then press the button.
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2. Select Lock/Unlock, and then press the
button.

3. When the Lock Service appears, enter the
PIN using the number buttons on your remote
control.

4. Tolock an application, select the application,
and then press the button. A lock
appears on the app. Repeat to lock other,
individual apps.

5. Tounlock a locked app, select the
application, and then press the button.

6. Tolock all the apps at once, use the 4 b
buttons to select the Lock All button, and
then press the &) button.

7. To unlock all the locked apps at once, use the
4 b buttons to select the Unlock All button
and then press the button.

8. Press the RETURN button twice to return to
the Apps screen. Locked apps will display a
lock on the upper right side.

Edit My Apps

Edit My Apps lets you add apps to and delete
apps from My Apps. It also lets you change the
position of an app in My Apps.

Add an App to My Apps

1. Onthe Downloaded screen, use the A b
buttons to go to Edit at the top of the screen,
and then press the button.

2. Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.

3. Select a full color app from the top row of
apps, and then press the button. The
full color app icon appears in the My Apps
area below and the app icon in the top row is
grayed out.

| NOTES |
» Grayed out apps are already in My Apps.
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4. When you return to the Apps screen, the app
will appear in the My Apps area.

Delete an App from My Apps

1. Onthe Downloaded screen, use the A &
buttons to go to Edit at the top of the screen,
and then press the button.

2. Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.

3.  Select the app you want to delete from My
Apps, press the button, and then press
the 47 € button in the direction of the X.
The Remove from My Apps pop-up appears.

4. Select Yes, and then press the button.

5. When you return to the Apps screen, the app
will have been removed from the My Apps
area.

Move an App in My Apps

1. Onthe Downloaded screen, use the 4 &
buttons 1o go to Edit at the top of the screen,
and then press the button.

2. Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.

3. Select the app you want to move in My Apps,
press the button, and then press the
4 ¥ <€ button to move the app icon in the
direction of one of the arrows (<, >, #, etc.)
that appears around the app icon. The app
icon moves in the direction you have chosen.

4.  After you have placed the app icon where
you want, press the button.

5. When you return to the Apps screen, the
app will be positioned in the location you had
selected.



Create Folder

Create Folder lets you create a folder on the
Downloaded screen into which you can put apps.

1.

On the Downloaded screen, use the 4 b
buttons to go to Edit at the top of the screen,
and then press the button.

Select Create Folder, and then press the
button. The Set Folder Name pop-up
appears.

Press the button. The keyboard appears.

Select the Clear button on the right side,
and then press the button to remove
Folder 1 from the entry field. Then, using the
keyboard, enter the name you want to apply
to the folder.

When finished, select the Done button on the
right side, and then press the button.
The pop-up reappears.

Select OK, and then press the button.
The new folder appears in the list of apps on
the left side of the screen.

Move to Folder

Move to Folder lets you move apps to the folder of
your choice.

1.

On the Downloaded screen, use the 4 b
buttons to go to Edit at the top of the screen,
and then press the button.

Select Move to Folder, and then press

the button. The Move to Folder screen
appears.

Use the B €V 4 buttons to move to an app,
and then press the button to select the
app. A check appears in the upper left corner
of the app.

To deselect an app, press the button.
The check disappears.

Repeat Step 3 to select additional apps.

| NOTES |

L4

To select all the downloaded apps, select Select All at the
top right of the screen, and then press the button. To
deselect all the apps, select Deselect All at the top right
of the screen, and then press the button.

When done, select Select folder at the top
of the screen, and then press the button.
The Select folder pop-up appears.

In the Select folder pop-up, use the A ¥
buttons to select the folder you want to move
the apps you selected to and then press the
button.

The Apps Moved pop up appears. Press the
button.

To open a folder, use the A ¥ € » buttons to
highlight the folder, and then press the
button.

Rename Folder

Rename Folder lets you rename an existing folder.

1.

On the Downloaded screen, use the A b
buttons to go to Edit at the top of the screen,
and then press the button.

Select Rename Folder, and then press

the button. The Rename Folder screen
appears, and a folder is highlighted.

User the 4 ¥ € buttons to highlight a
folder of your choice, and then press the
button. The Rename pop-up appears.

Press the button. The keyboard appears.
Enter the new name for the folder. When
finished, select Done on the right side, and
then press the button. The Rename pop-
up reappears displaying the new name.
Select OK, and then press the button.
The folder is renamed.

Select Close on the right side of the screen,
and then press the button.
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Delete

Delete lets you delete apps and folders from the
My Apps screen. If there are apps in a folder,

both the folder and the apps are deleted together.
Delete removes apps permanently. If you decide
you want to use an app you deleted, you will nesd
to download it again.

1. Onthe Downloaded screen, use the A b
buttons to go to Edit at the top of the screen,
and then press the button.

2. Select Delete, and then press the button.
The Delete screen appears.

3. Usethe 4 ¥ «p buttons to move to an app,
or folder and then press the button to
select. A check appears in the upper left
corner of the app or folder you selected.

4. To deselect an app, press the button.
The check disappears.

5. Repeat Step 3 to select additional apps or
folders.

I NOTES |

» To select all the downloaded apps, select Select All at the
top right of the screen, and then press the button. To
deselect all the apps, select Deselect All at the top right
of the screen, and then press the button.

6. After you have made all your selections,
select Delete at the top of the screen, and
then press the button. The Delete pop-
up appears.

7. Select Yes, and then press the button.
All the apps you selected are deleted.

I NOTES |

» You cannot immediately delete a locked app or folder.
If you select a locked app or folder to delete, when you
perform Step 7, the Lock Service pop-up appears. Enter
the Security PIN into the pop-up, and then press the
button. The lock will be released and the app or folder will
be deleted.
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Update Apps

Update Apps automatically searches the Internet
for updated versions of the apps you have
downloaded and updates them if it finds newer
versions.

1. Onthe Downloaded screen, use the A &
buttons 1o go to Edit at the top of the screen,
and then press the button.

2. Select Update Apps, and then press the
button.

3. The unit searches the Internet for newer
versions of your apps. If there are new apps,
the Update Apps pop-up appears.

4. To download the update for a particular app,
highlight the app, and then press the
button. A check appears to the left of the
app.

5. To deselect the app, highlight it, and then
press the &) button.

I NOTES |

» To select all the updates, select Select All on the right of
the pop-up, and then press the button. To deselect
all the updates, select Deselect All, and then press the
button.

6. After you have selected the updates you
want to download, select Update on the right
side of the pop-up, and then press the
button.

7. The unit downloads the updates you have
chosen. A download bar appears in each
app icon as the update for that app is
downloaded. The download is complete
when the download bars disappear.



The Screen Mirroring function lets you view the
screen of your smart phone or android tablet on
the TV you have connected to the Blu-ray player.

1. With the Blu-ray's Home screen displayed,
press the BLUE (D) button on the remote.
The Screen Mirroring pop-up appears.

2. Launch AllShare Cast or Miracast on your
device.

3. On your device, find the name of the Blu-ray
player in the list of available devices and then
select it.

4. The TV will display a PIN. Enter the PIN into
your device.

5. The TV displays a connecting message (for
example, Connecting to Android_92gb...) and
then displays the connected message.

6. In afew moments, the scresn of your device
appears on the TV screen.

I NOTES |

» When you are using the Screen Mirroring function, video
stuttering or audio dropouts may oceur, depending on
your environment.

Before using the Screen Mirroring function, confirm that
your smart phone has a compatible function. Depending
on your smart phone, the Screen Mirroring function may
have a different name ( AllShare Cast, etc.).

Bluetooth transmissions can interfere with the Screen
Mirroring signal. Before using the Screen Mirroring
function, we strongly recommend that you turn off the
Bluetooth function on your smart phone or smart device
{tablet, etc.).

L4
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You can access the Internet using the Web
Browser application.

Select Web Browser on the Home screen, and
then press the &) button.

| NOTES |

» When you run the Web Browser with the player connected
by HDM! to a BD Wise compatible TV - and BD Wise Is on
- the browser is maximized to fill the screen and the TV's
resolution is set o the optimal resolution automatically.

The Web Browser is not compatible with Java
applications.

If you attempt to download a file, and the file cannot be
saved, an error message will appear.

E-commerce (purchasing products online} is not
supported.

ActiveX Is not supported.

Access may be blocked to some websites or to web
browsers operated by certain businesses.

L4

L4

L4

L4

L4

Link Browsing and Pointer Browsing

The Web Browser provides two types of browsing,
Pointer Browsing and Link Browsing. When you
launch the browser for the first time, Pointer
Browsing is active. If you are using a mouse 1o
navigate in the Web Browser, we recommend
leaving Pointer Browsing active. If you are using
your remote to navigate in the Web Browser, we
recommend that you replace Pointer Browsing
with Link Browsing. Link Browsing moves a
highlight from one link to the next in the Web
Browser and is much faster than Pointer Browsing
if you are using your remote.

To activate Link Browsing, follow these steps:

1. Usethe 4 ¥ € B buttons on your remote to
move the pointer to the Link Browser icon on
the top right of the screen. The Link Browser
icon is the third icon from the right.

The pointer will be in the correct position
if the icon turns blue and the words “Link
Browsing” appear on the screen.

2. Pressthe button. Link Browsing is
activated and will remain active whenever you
bring up the Web Browser.
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The Control Panel at a Glance

Using the Keyboard Pop-up

The Control Panel, which runs across the top

of the screen, has a series of icons which start

a number of useful functions. The icons are
described below, starting with the icon on the far
left of the screen.

i3 Moves to the previous page.

{22  Moves to the next web page.

{4 : Displays the Bookmarks and History screen.
You can bookmark the current page, select

an existing bookmark, and edit and delete
bookmarks. You can also view your browsing
history and select a page to revisit.

4 : Moves to the Home screen of the Web
Browser.

/AW, SAMSLINg.Com

1 Lets you enter a page

address manually using the keyboard pop-up.

{7 : Reloads the current page so that it is

refreshed on the screen.

o e [ : Adds the current page to your bookmarks.

1+ Lets you search for information

by entering words or characters using the

keyboard pop-up. See Using the Keyboard Pop-

up on page 52.

. Lets you enlarge or shrink the screen
yvanous percentages.

{64 : Turns on the PIP function.

§d : Lets you switch between Pointer Browsing

and Link Browsing.

{44 : Lets you configure the Browser's settings.

See Using the Setlings Menu on page 53.

e [ Closes the Web Browser.

[ 52 english

When you cllck the , the

Q _lor access a data or text entry field,
and then press the (& button, the keyboard pop-
up appears.

To use the keyboard pop-up with your remote,
follow these steps:

hittp:/Awww.samsung.com

1. Usethe 4 ¥ € buttons on your remote 1o
move the highlight to a letter or number of
your choice.

2. Pressthe button to enter the letter or
number into the entry field.

3. To access capital letters, move the highlight
to the Caps key on the top left, and then
press the {8 button. Press the [ button
again with the Caps key highlighted 1o
access small letters again.

4.  To access symbols and additional punctuation
marks, highlight the 123#8& button on the left,
and then press the button.

5. To delete a character you entered, move the
highlight to the « button, and then press the

button.

6. To delete all the characters you entered,
move the highlight to the Clear button, and
then press the &3 button.

7. When finished entering, move the highlight
to the Done button, and then press the
button.



I NOTES |

» |f you have a wireless keyboard connected to your
player, you can use the wireless keyboard to enter
letters, numbers, symbols, and punctuation. Note that
the wireless keyboard will work only when the keyboard
popup appears and can only be used to enter letters,
numbers, symbols, and punctuation.

Options on the Keyboard Pop-Up

To access the keyboard pop-up options, highlight
the {77 button on the bottom left of the keyboard,
and then press the button.

Select the language for the keyboard.

Language You can select English, French,
Russian, etc.

Heconimanded The keyboard will suggest

Text recommended words as you enter text.
You can turn this function On or Off.
The keyboard will predict the next letter
as you enter letters. The predictions

Brodict Next appegr ina ring around the letter you

{otier have just entered. You can select a

predicted letter or move to another
letter. You can turn this function On or
Off.

Using the Setting Menu

The Setting menu contains functions that control
how the Browser operates and Browser security
functions. To open the Setting menu, highlight
the {7 icon in the Control Panel, and then press
the button. To select an option in the setting
menu, highlight the option, and then press the
button.

Enable/Disable
Grabbing

Reading Tools

Approved Sites

Turns the Grabber function on and off.
When the Grabber function is on, you
can move a web page up and down
without dragging the scroll bar.

The Grabber function is only available
in Pointer Browsing.

Provides an easy-to-read page by
enlarging the main text.

This function is not available for all
pages.

Lets you restrict your children'’s access
to inappropriate web pages by allowing
access only to the web sites you have
registered.

Every time you access this function, the
PIN screen appears. The first time you
access this function, enter the default
PIN, 0000 using the number buttons
on your remote.

You can change the PIN using the
Reset password for the Approved Sites
function. See below.

Approved Sites Feature : Tumns the
Approved Sites function on or off.
Reset password for Approved Sites .
Change the Approved Sites password.
Add current site : Lets you add the
currently displayed web site to the
Approved Sites list.

Manage Approved Sites : Lets you
key in URLs to add to the Approved
Sites List and delete sites from the
Approved Sites list.

If you turn this function on and have
not added any sites to the Approved
Sites list, you will not be able to access
any Internet sites.
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Enable or disable the Privacy mode.
When the Privacy mode is enabled,
the browser does not retain the URLs
of sites you visit. If you want to enable
Privacy mode, select OK.

If the Privacy mode is running, the
“Stop” icon appears in front of the URL
at the top of the screen. To disable
Privacy mode, select it again when
Privacy mode is enabled.

Private
Browsing On/0ff

Set as homepage : You can set the
Browser's home page.

Pop-up Block : Turns the Popup Block
on and off.

Ad Block : You can determine whether
to block advertisements and select the
URLSs for which advertisements are
blocked.

General : You can delete personal
information such as website history
and browsing data (cookies, efc.), and
reset all web browser settings to their
factory defaults.

Encoding : You can set the Encoding
setting for web pages to Automatic or
select the encoding format manually
from alist.

Pointer : You can set the speed of the
cursor when the cursor is set to Pointer
and turn Smart Cursor On and Off.
Browser Information : Displays

the version number and copyright
information for the Web Browser.

Web Browser
Setling

Provides basic information about the

hew operation of the Web Browser.

I NOTES |

» Depending on the web site, some of the Web Browser
Setting functions may not be activated. Functions that are
not activated are greyed out and cannot be used.
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Accounts to the Player

The Link Service Accounts function lets you link
your player to your accounts with Internet services
such as Pandora so that the player can log you

in to the service automatically when you start the
app for that service.

To create a service account link, follow these
steps:

1. On the Home screen, press the RED (A)
button on your remote to log in to your
Samsung Account.

2. After you have logged in, press the RED (A)
button on your remote again.

3. Select Link Service Accounts in the My
Account pop-up, and then press the
button.

4. Onthe Link Service Accounts screen, select
the service you want to link to the player, and
then press the &3 button.

5. Select Register, and then press the
button.

6. IntheID and Password screen, enter the ID
you use to log in to the service you selected
using the pop-up keyboard. When finished,
select Done, and then press the button.

7. Repeat the same process for the password.
When finished select Done, and then press
the [ button.

8. Select OK, and then press the button.



Once the player is connected to your network, you
can enjoy various movie-related service contents
available on BD-LIVE compliant discs.

1. Attach a USB flash memory drive to the
USB jack on the front of the player, and then
check its remaining memory. The memory
device must have at least 1GB of free space
to accommodate the BD-LIVE services.

2. Select Settings on the Home screen, and
then press the &) button.

3. Select Network, and then press the
button.

4. Select BD-Live Settings, and then press the
button.

5. Select BD Data Management, and then
press the & button.

6. Select Select Device, and then press the
button.

7. Select USB device, and then press the
button.

8. Insert a Blu-ray Disc that supports BD-LIVE.

Select an item from the list of BD-LIVE service
contents provided by the disc manufacturer.

I NOTES |

» The way you use BD-LIVE and the provided contents may
differ, depending on the disc manufacturer.
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Appendix

_Compliance and Compatibility Notice

NOT ALL discs are compatible

¢ Subject to the restrictions described below and those noted throughout this Manual, including the Disc
Type and Characteristics section of this user manual, disc types that can be played are: pre-recorded
commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVD-RW/-R; and CD-RW/-R.
Discs other than the above cannot and/or are not intended to be played by this player. And some of
the above discs may not play due to one or more reasons provided below.

Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R,
DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not respond to
all operating commands or operate all features of every disc. These and other disc compatibility and
player operation issues with new and existing format discs are possible because:

- Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray Discs
because some features may be optional, additional features may have been added to the Blu-ray
Disc format after the production of this player, and certain available features may be subject to
delayed availability;

not all new and existing disc format versions are supported by this player;

- new and existing disc formats may be revised, changed, updated, improved and/or supplemented;
some discs are produced in a manner that allows specific or limited operation and feature during
playback;

- some features may be optional, additional features may have been added after the production of this
player or certain available features may be subject to delayed availability;

some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and
CD-RW/-R logos may still be non-standardized discs;

- some discs may not be played depending on their physical state or recording conditions;

problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the
manufacture of discs;

- this player operates differently than a standard DVD player or other AV equipment; and/or

for reasons noted throughout this user manual and for other reason(s) discovered and posted by
SAMSUNG customer care center.

If you encounter disc compatibility or player operation problems, please contact SAMSUNG customer
care center.

You may also contact SAMSUNG customer care center for possible updates on this player.

For additional information on playback restrictions and disc compatibility, refer to the Precautions,
Before Reading the user manual, Disc Types and Characteristics, and Before Playing sections of this
user manual.

For Blu-ray Disc Player progressive scan output : CONSUMERS SHOULD NOTE THAT NOT

ALL HIGH DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND
MAY CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN
PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO
THE 'STANDARD DEFINITION' OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET
COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTER.
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¢ Because AACS (Advanced Access Content System) is approved as content protection system for
Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain
restrictions are imposed on playback, analog signal output, etc., of AACS protected contents.

The operation of this product and restrictions on this product may vary depending on your time of
purchase as those restrictions may be adopted and/or changed by AACS after the production of this
product. Furthermore, BD-ROM Mark and BD+ are additionally used as content protection system for
Blu-ray Disc format, which imposes certain restrictions including playback restrictions for BD-ROM
Mark and/or BD+ protected contents. To obtain additional information on AACS, BD-ROM Mark, BD+,
or this product, please contact SAMSUNG customer care center.

Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only connect
your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted picture from
copy-protected Blu-ray Disc/DVDs.

Under the U.S. Copyright laws and Copyright laws of other countries, unauthorized recording, use,
display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs, and other
materials may subject you to civil and/or criminal liability.

Cinavia Notice : This product uses Cinavia technology to limit the use of unauthorized copies of
some commercially-produced film and videos and their soundtracks. When a prohibited use of

an unauthorized copy is detected, a message will be displayed and playback or copying will be
interrupted.

More information about Cinavia techinology is provided at the Cinavia Online Consumer Information
Center at http://www.cinavia.com. To request additional information about Cinavia by mail, send a
postcard with your mailing address to: Cinavia Consumer Information Center, P.O. Box 86851, San
Diego, CA, 92138, USA.

This product incorporates proprietary technology under license from Verance Corporation and is
protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending as well
as copyright and trade secret protection for certain aspects of such technology. Cinavia is a trademark
of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights reserved by Verance.
Reverse engineering or disassembly is prohibited.

All content and services accessible through this device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual property laws. Such content and services are
provided solely for your personal noncommercial use. You may not use any content or services in a
manner that has not been authorized by the content owner or service provider. Without limiting the
foregoing, unless expressly authorized by the applicable content owner or service provider, you may
not modify, copy, republish, upload, post, transmit, translate, sell, create derivative works, exploit, or
distribute in any manner or medium any content or services displayed through this device.
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Appendix

THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS 18." SAMSUNG DOES NOT WARRANT
CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE.
SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED
TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG
DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS
OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN
CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY
CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Third party services may be terminated or interrupted at any time, and Samsung makes no representation
or warranty that any content or service will remain available for any period of time. Content and services
are transmitted by third parties by means of networks and transmission facilities over which Samsung
has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any
responsibility or liability for any interruption or suspension of any content or service made available
through this device.

Samsung is neither responsible nor liable for customer service related 1o the content and services.

Any guestion or request for service relating to the content or services should be made directly to the
respective content and service providers.

License

¢ Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol m DOLBY

are registered trademarks of Dolby Laboratories. T YRUENS |
“DIGITAL PLUS |
¢ Manufactured under license under U.S. Patent Nos: 5,956,674; 5,974,380; = |

6,226,616; 6,487,5635; 7,212,872; 7,333,929; 7,392,195; 7,272,567 & other U.S. = %mﬂm
and worldwide patents issued & pending. DTS-HD, the Symbol, & DTS-HD and the

Symbol together are registered trademarks & DTS-HD Master Audio is a trademark of

DTS, Inc. Product includes software. © DTS, Inc. All Rights Reserved.

¢ The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Haml
Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United
States and other countries.

¢ Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names (
may be trademarks of their respective owners. 2—29
<
Java-

POWERED
¢ Open Source License Notice

- In the case of using open source software, Open Source Licenses are available on the product
menu.

¢ Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.
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Notes

3D Settings

e For some 3D discs, to stop a movie during 3D playback, press the ££8 (STOP) button once. The
movie stops and the 3D mode option Is de-activated.
To change a 3D option selection when you are playing a 3D movie, press the 28 (STOP) button
once. The Blu-ray menu appears. Press the 28 (STOP) button again, then select 3D Settings in
the Blu-ray menu.

e Depending on the content and the position of the picture on your TV screen, you may see vertical
black bars on the left side, right side, or both sides.

TV Aspect Ratio

e Depending on the disc type, some aspect ratios may not be available.

e |f you select an aspect ratio and option that is different than the aspect ratio of your TV screen,
the picture might appear to be distorted.

e |f you select the 16:9 Original, your TV may display 4.3 Pillarbox (black bars on sides of picture).

BD Wise (Samsung Players only)

e When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD Wise
appears in the Resolution menu.

e |f the player is connected 1o a device that does not support BD Wise, you can not use the BD
Wise function.

Settings e For proper operation of BD Wise, set the BD Wise option of both the player and the TV to On.

Digital Qutput

e Be sure 1o select the correct Digital Output or you will hear no sound or just loud noise.

e |fthe HDMI device (AV recelver, TV) is not compatible with compressed formats (Dolby Digital,
DTS), the audio signal outputs as PCM.

e Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.

e Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects.

e This Digital Output setup does not affect the HDMI audio output to your TV.
It affects the optical and HDMI audio output when your player is connected to an AV receiver.

e |f you play MPEG audio soundtracks, the audio signal outputs as PCM regardiess of your Digital
Output selections (PCM or Bitstream).

PCM Downsampling

e Even when PCM Downsampling is set to Off, some discs will only output downsampled audio
through the optical digital output.
e HDMI
- |fyour TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the
player may output PCM 2ch downmixed audio even though you selected Bitstream (either
Reencoded or Unprocessed) in the setup menu.
- |fyour TV is not compatible with PCM sampling rates over 48kHz, the player may output
48kHz.
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Sellings

Media Play

160 english

BD-LIVE Internet Connection

e What is a valid certificate?
When the player uses BD-LIVE to send the disc data and a request to the server to certify the
disc, the server uses the transmitted data to check if the disc is valid and sends the certificate
back to the player.

o The Internet connection may be restricted while you are using BD-LIVE contents.

BD Data Management

¢ |n the external memory mode, disc playback may be stopped if you disconnect the USB device in
the middle of playback.

o Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are supported.
We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or faster
read/write speed.

o The Resume Play function may not work after you format the storage device.
o The total memory available to BD Data Management may differ, depending on conditions.

Anynet+ (HDMI-CEC)

e Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user
manual of your TV.

o This function is not available if the HDMI cable does not support CEC.
o |f your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.

Selecting the Audio Language

e The < ¥ Indicator will not appear on the screen If the BONUSVIEW section does not contain any
BONUSVIEW audio settings.

o The languages available through the Audio Language function depend on the languages that are
encoded on the disc. This function or certain languages may not be available.

e Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio soundtrack in
English.

Selecting the Subtitle Language

e Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language in the
Disc Menu. Press the DISC MENU button.

o This function depends on the selection of subtitles that are encoded on the disc and may not be
available on all Blu-ray Discs/DVDs.

o Information about the main feature BONUSVIEW mode will also appear if the Blu-ray Disc has a
BONUSVIEW section.

o This function changes both the primary and secondary subtitles at the same time.
o The total number of primary and secondary subtitles are displayed respectively.

o |f you press the SUBTITLE button on the remote control, the subtitle bar appears.
Press the RETURN button to remove the subtitle bar.




Resolution according to the contents type

B

e C
BD Wise Resolution of Blu-ray Disc 1080p@60F }:5
Movie Frame : Auto 1080p@24F 1080p@24F %
o Movie Frame : Off Max. Resolution of TV input Max. Resolution of TV input *
Movie Frame : Auto (24Fs) 1080p@24F 1080p@24F
1080p (Movie Frame : Off) 1080p@60F 1080p@60F
10801 10801 10801
720p 720p 720p
480p 480p 480p
VD
BD Wise 4801
DVD 24Fs Conversion : Auto 1080p@24F

Movie Frame : Auto

Auto DVD 24Fs Conversion : Off Max. Resolution of TV input
Movie Frame : Off Max. Resolution of TV input
1080p 1080p@60F
10801 10801
720p 720p
480p 480p
I NOTES |

» | the TV you connected to the player does not support Movie Frame or the resolution you selected, the message "/f no
pictures are shown after selecting 'Yes', please wait for 15 seconds o refurn to the previous resolution. Do you want fo
change the resolution?" appears. If you select Yes, the TV's screen will go blank for 15 seconds, and then the resolution will

rever! fo the previous resolution automatically.

L4

If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the B bution

on the top of the player for more than 5 seconds. All settings are restored to the factory default. Run the Initial Settings
procedure again. Then, go to Settings > Display > Resolution in the Menu, and select the correct resolution for your TV.

L4

When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format) only. Resetting

does not affect your network settings, so you should be able 1o skip Network Setup and Software Update.

L4

L4

When the factory default settings are restored, all stored user BD data will be deleted.
The Blu-ray Disc must have the 24 frame feature for the player to use the Movie Frame (24Fs) mode.
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Digital Output Selection

Bitotroim Bitstream Bitstream
Setup (Unprocessed) (Re-encoded | [Re-encoded
p oTS) Dolby D)
HDMI HDMI . Hom; | KoMt supporte
Connection supported | Optical | supported | Optical o . AV receiver or
. . teceiver ot :
AV receiver AV receiver . Optical
Optical
pom | UPOPCM oevon | pom | poMach |D7S reencoded ] Fe-encoded
7.1ch Dolby Digital
- Up to PCM - - Re-encoded
Dolby Digital 71eh PCM 2ch § Dolby Digital | Dolby Digital § DTS re-encoded Dolby Digital *
Dolby Digital § Up to PCM Dolby Digital - ) Re-encoded
Plis 71eh PCM 2ch Plus Dolby Digital § DTS re-encoded Dolby Digital *
Audio Stream Up to PCM - Re-encoded
on Blu-ray Dolby TrueHD 71eh PCM 2ch §Dolby TrueHD | Dolby Digital § DTS re-encoded Dolby Digital *
Disc
Up to PCM Re-encoded
DTS B.1ch PCM 2ch DTS DTS DTS re-encoded Dolby Digital *
DTS-HD High DTS-HD High
Resolution Up7t ﬂ Eﬁ M PCM 2ch § Resolution DTS DTS re-encoded Di?l;erg:ioﬁgid*
Audio ' Audio yrg
DTS-HD Up to PCM DTS-HD Re-encoded
Master Audio | 7.1ch | TOM 2N Npasteraucio| DTS [DTSTeencoded b p pigital *
PCM PCM2ch | PCM2ch | PCM 2ch PCM 2ch PCM 2ch PCM 2ch
Audio Stream | Dolby Digita Up;ﬂ EhCM PCM 2ch | Dolby Digital | Dolby Digtal | Dolby Digital | Dolby Digital
on DVD -
ors | POFM | poyaen | ot DTS DTS DTS
Decodes the maing Decodes the main
feature audio  § feature audio and
Outputs only the main | and BONUSVIEW § BONUSVIEW audio
Decodes the main feature ffeature audio stream so that  audio stream stream together
Definition for audio and BONUSVIEW  gyour AV recelver can decodetogether into PCM{into PCM audio and
Bil-ray Disc Any audio stream together the audio bitstream. audio and adds § adds Navigation
Y into PCM audio and adds You will not hear Navigation Sound§  Sound Effects,
Navigation Sound Effects. BONUSVIEW audio or Effects, then re- § then re-encodes
Navigation Sound Effects. fencodes the PCME  the PCM audio
audio into DTS | into Dolby Digital
bitstream. bitstream or PCM.

* If the Source Stream is 2¢h or mono, "Re-encoded Dolby D" Settings are not applied. Output will be

PCM 2¢h.

Blu-ray Discs may include three audio streams :
- Main Feature Audio : The audio soundtrack of the main feature.
- BONUSVIEW audio : An additional soundtrack such as the director or actor's commentary.

- Navigation Sound Effects : When you choose some menu navigation, Navigation Sound Effects may
sound. Navigation Sound Effects are different on each Blu-ray Disc.
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Before requesting service, please try the following solutions. 9
PROBLEM SOLUTION Z

]

No operation can be performed with the e Check the batteries in the remote control. They may need replacing. g
remote control. 3

e Operate the remote control at a distance of no more than 20 feet from the
player.

¢ Remove the batteries and hold down one or more buttons for several
minutes to drain the microprocessor inside the remote control to reset it.
Reinstall the batteries and try to operate the remote control again.

The disc does not play.

e Ensure that the disc is installed with the label side facing up.
e Check the region number of the Blu-ray Disc/DVD.

The disc Menu does not appear.

e Ensure that the disc has disc menus.

The prohibition message appears on the
screen.

e This message appears when an invalid button is pressed.

e The Blu-ray Disc/DVD's software doesn't support the feature (e.g., angles).

e You've requested a title or chapter number or search time that Is out of
range.

Play mode differs from the Setup Menu
selection.

e Some of the functions selected in the Setup Menu may not work properly if
the disc is not encoded with the corresponding function.

The screen ratio cannot be changed.

o The Screen Ratio is fixed on your Blu-ray Disc/DVD.
o This is not a problem with the player.

No audio.

o Make sure you have selected the correct Digital Output in the Audio Options
Menu.

The screen is blank.

o |f the HDM! output is set to a resolution your TV cannot support (for
example, 1080p), you may not see a picture on your TV.

o Press the B button (on top panel) for more than 5 seconds with no disc
inside. All settings will revert to the factory setlings.

e When the factory default settings are restored, all stored user BD data will
be deleted.

Forgot password.

e Press the B button (on top panel) for more than 5 seconds with no disc
inside. All settings Including the password will revert to the factory setlings.
Don't use this unless absolutely necessary.

e When the factory default settings are restored, all stored user BD data will
be deleted.
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Appendix
PROBLEM SOLUTION

The picture is nolsy or distorted. o Make sure that the disc is not dirty or scratched.
e (lean the disc.

No HDMI output. e Check the connection between the TV and the HDMI jack of the player.
o Check if your TV supports the 480p, 720p, 1080i or 1080p HDMI input
resolution.
Abnormal HDMI output screen. o |f random noise appears on the screen, it means that TV does not support

HDCP (High-bandwidth Digital Content Protection).

If you experience other problems. e (o to the table of contents and find the section of the user manual that
contains information about the feature you are having the problem with,
and then follow the procedure again.

o |f you still cannot resolve the problem, please contact your nearest
Samsung authorized service center.

AllShare function

| can see folders shared through AliShare, o AllShare only shows Video, Photo, and Music files. Other types of files are

but | cannot see the files. not displayed.
The video plays intermittently. e Check If the network is stable.
o Check if the network cable is properly connected and if the network is not
overloaded.

o The wireless connection between the AllShare compatible device and the
player Is unstable.
Check the connection.

The AliShare connection between the player | e IP addresses within the same subnetwork should be unique.
and the PC is unstable. If they are not, IP interference can cause this phenomenon.
e Check if you have a firewall enabled.

If so, disable the firewall function.
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PROBLEM SOLUTION
B

BD-LIVE =

| cannot connect to the BD-LIVE server. e Test whether the network connection is working using the Network Status >
function. (See page 21) ke

e Check whether a USB memory device is connected to the player. 2

e The memory device must have at least 1GB of free space to accommodate %

the BD-LIVE senvice.
You can check the avallable size in BD Data Management. (See page 22)

e See if the BD-LIVE Internet Connection option is set to Allow(All).
e |f all above fails, contact the contents provider or update 1o the player to the
latest firmware.

e The memory device must have at least 1GB of free space to accommodate

the BD-LIVE senvice.
You can check the avallable size in BD Data Management. (See page 22)

When using the BD-LIVE service, an error
oceurs.

I NOTES |
» When the factory default settings are restored, all stored user BD data will be deleted.

Repairs
If you contact us to repair your player, an administration fee may be charged if either:

1. Anengineer is called out to your home at your request and there is no defect in the product.
2. You bring the unit to a repair center and there is no defect in the product.
We will provide you with the amount of the administration fee before we make a home visit or begin any

work on your player.
We recommend you read this manually thoroughly, search for a solution on line at www.samsung.com, or

contact Samsung Customer Care at 1-800-SAMSUNG (726-7864) before seeking to repair your player.
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Specifications

Power Requirements AC110-120V 50/60Hz
Power Consumption 17TW
o Weight 2.6 Ibs
Dimensions 14.2 (W)X 7.7 D) X 1.6 (H) inches
Operating Temperature Range +41°F to +95°F
Operating Humidity Range 10%t075%
Use Type A UsB 2.0
DC output 5V 500mA Max.
Video 2D : 1080p, 1080, 720p, 480p
HOMI 3D 1080p, 720p
Audio PCM, Bitstream
Audio Output Digital Audio Output Optical
Ethemet 100BASE - TX Terminal
Wireless LAN Built-in
WEP (OPEN/SHARED)
o Security WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)
WPS(PBC) Supported

¢ Network speeds equal to or below 10Mbps are not supported.
¢ Design and specifications are subject to change without prior notice.

¢ Weight and dimensions are approximate.

¢ Dispose unwanted slectronics through an approved recycler.
To find the nearest recycling location, go to our website: www.samsung.com/recyclingdirect or call, (877)

278 - 0799.
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This SAMSUNG brand product, as supplied and distributed by SAMSUNG and delivered new, i the original carton to the
original consumer purchaser, is warranted by SAMSUNG against manufacturing defects in materials and workmanship for
a limited warranty period of:

One (1) Year Parts and Labor*
(*90 Days Parts and Labor for Commercial Use)

This limited warranty begins on the original date of purchase, and is valid only on products purchased and used in the
United States. To receive warranty service, the purchaser must contact SAMSUNG for problem determination and service
procedures. Warranty service can only be performed by a SAMSUNG authorized service center. The original dated bill

of sale must be presented upon request as proof of purchase to SAMSUNG or SAMSUNG's authorized service center.
Transportation of the product to and from the service center is the responsibility of the purchaser.

SAMSUNG will repair or replace this product, at our option and at no charge as stipulated herein, with new or reconditioned
parts or products if found to be defective during the limited warranty period specified above. All replaced parts and
products become the property of SAMSUNG and must be returned to SAMSUNG. Replacement parts and products
assume the remaining original warranty, or ninety (90) days, whichever is longer.

SAMSUNG's obligations with respect to software products distributed by SAMSUNG under the SAMSUNG brand name
are set forth in the applicable end user license agreement. Non-SAMSUNG hardware and software products, if provided,
are on an "AS IS" basis.

Non-SAMSUNG manufacturers, suppliers, publishers, and service providers may provide their own warranties.

This limited warranty covers manufacturing defects in materials and workmanship encountered in normal, and except to
the extent otherwise expressly provided for in this statement, noncommercial use of this product, and shall not apply to the
following, including, but not limited to: damage which occurs in shipment; delivery and installation; applications and uses
for which this product was not intended; altered product or serial numbers; cosmetic damage or exterior finishy; accidents,
abuse, neglect, fire, water, lightring or other acts of nature; use of products, equipmert, systems, utilities, services, parts,
supplies, accessories, applications, installations, repairs, external wiring or connectors not supplied and authorized by
SAMSUNG, or which damage this product or result i service problems; incorrect electrical line voltage, fluctuations and
surges; customer adjustments and failure to follow operating instructions, cleaning, maintenance and environmental
instructions that are covered and prescribed in the instruction book; product removal or reinstallation; reception problems
and distortion related to noise, echo, interference or other signal transmission and delivery problems. SAMSUNG does not
warrarit unirterrupted or error-free operation of the product.

THERE ARE NO EXPRESS WARRANTIES OTHER THAN THOSE LISTED AND DESCRIBED ABOVE, AND NO
WARRANTIES WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, SHALL APPLY AFTER THE EXPRESS WARRANTY
PERIODS STATED ABOVE, AND NO OTHER EXPRESS WARRANTY OR GUARANTY GIVEN BY ANY PERSON, FIRM OR
CORPORATION WITH RESPECT TO THIS PRODUCT SHALL BE BINDING ON SAMSUNG. SAMSUNG SHALL NOT BE
LIABLE FOR LOSS OF REVENUE OR PROFITS, FAILURE TO REALIZE SAVINGS OR OTHER BENEFITS, OR ANY OTHER
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE

THIS PRODUCT, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF SAMSUNG
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST
SAMSUNG BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT SOLD BY SAMSUNG AND
CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, PURCHASER ASSUMES ALL RISK AND
LIABILITY FOR LOSS, DAMAGE OR INJURY TO PURCHASER AND PURCHASER'S PROPERTY AND TO OTHERS AND
THEIR PROPERTY ARISING OUT OF THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT SOLD BY SAMSUNG
NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF SAMSUNG. THIS LIMITED WARRANTY SHALL NOT EXTEND TO
ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THIS PRODUCT, 1S NONTRANSFERABLE AND STATES YOUR
EXCLUSIVE REMEDY.

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of incidental or
consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal
rights, and you may also have other rights which vary from state to state.

To obtain warranty service, please contact SAMSUNG customer care center.



QUESTIONS OR COMMENTS?

COUNTRY CALL OR VISIT US ONLINE AT WRITE
Samsung Electronics America, Inc.
INTHE US 1-800-SAMSUNG WWW.SAMSUNg.com 85 Challenger Road Ridgefield Park,

(726-7864)

NJ 07660-2112

AK68-02285N



